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Introduction 

Training Overview 

Intended Audience 

This guide is intended for those users who will create reports, dashboards 

and other objects in BLUEcloud Analytics. 

Prerequisite 

There is no pre-requisite knowledge necessary before using this guide. 

However, being familiar with your library’s policies will be beneficial.  

Supplementary Documentation 

Please consult the Data Reference Guide, available in the SirsiDynix 

Support portal, as you learn more about and work with this product. The 

Data Reference Guide provides detailed information on the data attributes 

available in BLUEcloud Analytics. Most attributes are available for both 

Horizon and Symphony customers, but there are some exceptions. The 

Data Reference Guide details these exceptions and much more.  

Goals 

After completing this guide and/or the corresponding course, users will 

be able to: 

 Create Reports and Dashboard Visualizations 

 Filter and format Reports and Dashboards 

 Set user preferences 

 Share Objects with other users of BLUEcloud Analytics 

 Schedule Reports for delivery via email  

Getting Connected 

Access information to your particular instance of BLUEcloud Analytics 

will not be provided during training. Your Site Administrator should 

receive the following information from your SirsiDynix Project Manager: 

 URL for your instance of BLUEcloud Analytics 

 Delivered usernames and passwords 
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BLUEcloud Analytics 
Overview 

Introduction 

BLUEcloud Analytics is the latest generation of reporting tools for the SirsiDynix 

Symphony and Horizon ILS systems. Used to its full potential, not only is it “a reporting 

tool”, but also incorporates the concept of “analytics”. 

Most library personnel are already familiar with the general concept of a “report”: a grid 

or graph of data that mainly describes things that have already happened.  

While analytics will also shows you plenty of grids and graphs, the difference lies in the 

objective. Analytics is more about trends, and anticipating future needs. In other words, 

analytics is more concerned with presenting data indicating what will likely happen. 

User Levels and Privileges 

BLUEcloud Analytics is delivered with one administrative login. This login is created 

with admin level privileges. This is the highest level of privileges available. Users at this 

level can view reports, create dashboards, and create and save reports to any directory 

under their project.  

 

NOTE: Additional logins can be created only by contacting Customer Support. 

When requesting additional logins, you’ll want to specify what level or set of privileges 

should be assigned to each login. BLUEcloud Analytics users are divided into four 

levels. Each user level has privileges that allow them to use different features of the 

product. The following bullet points provide an overview of each user level: 

 Admin 

o Can create and save any report to all directories under the project, in 

addition to all Creator functions. 

o Limited to 15 users per subscription, including Creator users. 

 Creator 

o Can create and save any report to My Reports, in addition to all Analyst 

functions. 

o Limited to 15 users per subscription, including Admin users. 

 Analyst 

o Can create dashboards and basic reports and save to “My Reports”, in 

addition to all Viewer functions. 

o Unlimited number of users allowed. 
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 Viewer 

o Can only view reports, has no creation privileges. 

o Unlimited number of users allowed. 
 

 NOTE: More detailed information about the privileges assigned to these groups is available in 

BLUEcloud Analytics User Levels Guide available on the Support Portal. Additional 

subscriptions can be purchased to accommodate your library’s needs. 

Terminology 

Datasets 

A dataset, as the name suggests, is the data you will be extracting 

information from in BLUEcloud Analytics. Data from your ILS is 

harvested nightly via an automated extraction process. 

Reports 

In BLUEcloud Analytics, the term “report” actually refers to a specific 

type of object that is a simple grid/graph focusing on one set of data. An 

example of something that might typically be shown as a report would be 

a count of your patrons by various categories, like a Horizon bType or a 

Symphony user category. 

Reports are well suited, not only for “count” reports, but also for list 

reports such as lists of titles or lists of users. If you ever want to list 

something, a Report is always the best object to use. 

Remember that some attributes are only available in Reports so if you 

would like access a specific attributes data, for example, User Barcode you 

would always want to create a Report. Consult the Data Reference Guide 

for more information about the availability of attributes. Reports data can 

later be pulled into dashboards. It is often useful to create a report with 

the data you wish to view first, in order to use it in a dashboard. 

Dashboards 

A dashboard is a special type of object deployed in a Flash format. 

Dashboards are a collection of important data that would benefit a 

decision maker “at-a-glance”. For example, your cataloging supervisor 

might like a dashboard of several graphs that show general trends (items 

added by category or weeding activity), which can then be examined in 

more depth later. 

Dashboards also can be highly interactive. Where reports are generally 

read-only in nature, a dashboard can have graphical elements on it that 
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let you view the data in different ways. You can dynamically apply 

filters, add a new metric, zoom in on a category of interest, copy data to 

another window, and zoom out again. All without ever leaving the 

current window, or flipping in and out of an “edit” mode. 

Dashboards are especially well suited to the mindset behind analytics, 

and can serve different types of audiences from decision makers to staff.  

For decision-makers, with a properly designed set of dashboards, you can 

have critical data about various library operations in front of you on one 

screen. Further, you can analyze, filter, and change the output in many 

ways without leaving the dashboard. The example below shows how 

these types of dashboards could look:  

 

 In the Dashboard Formatting chapter later in this guide, we will see that 

dashboards have even more sophisticated design potential, such as the 

ability to divide a dashboard into tabbed/sub-tabbed pages of content. 

On the other hand, not everyone requires complex reporting like this. 

What if your circulation supervisor just wants a simple grid of checkout 

data? Dashboards can also present themselves much like a basic report: 
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Visualization 

Earlier in this section, we discussed “cubes”, which are multi-

dimensional matrices of data. BLUEcloud Analytics cubes are rather large 

sets of data that no human being could digest. Therefore, we need 

something that can present only the data from that cube we really want. 

Visualizations are what you use in a dashboard to provide a specific view 

of the data. You can think of them as a close equivalent of a “report” that 

comes in the form of grids and/or graphs. Your dashboards can have one-

to-many visualizations, depending on how much data you would like to 

present. 

A simple dashboard may have just one visualization. More complex ones 

can have multiple visualizations, such as the example above with two: a 

graph and grid side-by-side. 

 



BLUEcloud Analytics Training Guide, Page 11 

Metrics  

Much of your analysis will focus on gathering statistics. Metrics are 

objects in the cube that you will use to present numbers in your analysis. 

Examples of metrics might include “number of checkouts” or “number of 

renewals”. When working with reports, you will typically use delivered 

metrics. When working with dashboards you will not have access to 

delivered metrics and will instead create derived metrics.  

Derived metrics 

Derived metrics perform calculations on data just as delivered metrics do, 

but these calculations are done “on-the-fly”. These metrics can only be 

used for the dashboard in which they are created but provide greater 

flexibility in reporting and advanced calculations.  

Attributes 

Attributes are objects in the cube that can give numbers context. 

Examples of attributes might include “library” or “checkout year”. Your 

system will come delivered with a set of attributes in each cube.  

Filters 

Filters sift through your data and pull into your report only the 

information that you require in the report results. This makes the data in 

your report easier to understand and displays only the data the user 

needs to complete their analysis.  

A filter is made up of one or more qualifications. Qualifications define the 

conditions that must exist for the data to be included in the report. We 

can join filters with Boolean logic such as AND or NOT.  

Report Filters 

Report filters are used to limit the display of data in a report, document 

or dashboard. We create report filters as we design the report and the 

filter is saved as part of the report’s definitions.  

View Filters 

A report filter restricts how much data is retrieved from the dataset, but 

we can also filter data after the report results have been displayed using a 

view filter. This type of filter dynamically limits the data displayed on the 

report without the user having to re-execute the report. Report filters can 

be combined with view filters within the same report. The report filter 

returns results, which the view filter further restricts.  
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Standalone Filters 

Standalone filters are created as independent objects in BLUEcloud 

Analytics. Unlike, report filters, stand-alone filters can be reused in many 

different reports, documents or dashboards.  

Derived elements 

Derived elements are used in reports to group attributes together. Much 

like derived metrics, you can use derived elements to create groups on-

the-fly while viewing a report. These groups provide a new way to view 

report data. For example, you could group data together by season 

(winter, spring, summer, and fall), by type (school libraries, academic 

libraries and public libraries) or by geographic area (Northside libraries 

and Southside libraries).  

Personally Identifiable Information (PII) 

Personally Identifiable Information or PII is considered to be any 

information that could be used to locate, contact or identify a person. In 

Horizon and Symphony, PII consists of the following data from a user 

record: 

 Address 

 Birthdate 

 Email 

 First name, Last name, Middle name and Suffix 

 Phone number 

 User ID 

 

BLUEcloud Analytics does not harvest PII data by default from the ILS. 

If you would like PII available for reporting purposes in BLUEcloud 

Analytics, please open a case with Customer Support and request that it 

be made available in your instance of the product. 

Cubes and Queries 

Traditionally, reports are extracted from database tables and views out of a 

relational database, using either SQL statements or API calls. In addition to these 

types of queries, BLUEcloud Analytics also uses a type of data structure known 

as a cube, and accompanying technologies to support it. Cubes are used in 

creating Dashboards while Standard Reporting relies on queries.  

If you think of tables as “flat” grids of data, think of cubes as a multi-dimensional 

data source. Dashboards rely heavily on data from the Cubes. Cubes take all the 

data from a predefined matrix of data and transform it into dimensional data. 
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This means that all data is in the cube from the beginning. When querying the 

cube in a Dashboard, filters are used to narrow the data to just the information 

you’re interested in.  

Standard Reporting, on the other hand, is a query generator. In reports you will 

choose the elements you want to display in a report and a specific query is 

created by the system to pull in only that data you have specified.  

BLUEcloud Analytics includes several different datasets. These datasets are 

available in Standard Reporting and most are also structured as cubes for 

Dashboard reporting.  

Each of the datasets is outlined in more detail in the following sections. 

Highlights of the delivered reports that accompany these datasets are also 

included. 

Delivered Reports 

The reports delivered with each dataset can be used as they are or 

modified to meet the reporting needs of your organization. They are 

intended to be used as templates or a “starting point” for reporting. This 

allows you to apply some of the techniques you will learn later in this 

guide to these reports to customize them for your needs.  

User Data 

Imagine that you would like to create a report that shows the number of 

patrons in your ILS whose library card has been expired for over a year.  

This type of report would be built from User data.  

NOTE: For steps on how to create this report, consult Exercise 1 in the List 

Reports section of this document.  

Within Standard Reporting there is a folder containing User attributes as 

shown below. Note that this is not a complete list of User attributes. 
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Within a Dashboard, these same attributes are accessible from the User 

Cube, with some exceptions. 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remember that within a dataset, some attributes can be accessed through 

Standard Reporting and some can only be accessed in a Dashboard. User 

Barcode is a good example; this attribute can only be accessed in Standard 

Reporting. Consult the Data Reference Guide for more information.  
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Delivered Reports & Dashboards 

User data is accompanied by four delivered reports and one dashboard 

(located within the Analysis Documents folder). These objects can be found 

in Shared Reports > User. 

 

Each of these reports is unique and provides a different analysis of your 

user data. For example, the User Counts by Last Activity report prompts 

you to enter a date range, and returns a number of users active during 

that time period.  
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MARC Data 

Imagine that you would like to create a report that lists all of the titles in 

your ILS that contain a specific phrase in a specific field of the 

bibliographic records. This type of report would be built from MARC 

data. 

NOTE: For steps on how to create this report, consult Exercise 2 in the List 

Reports section of this document.  

Within Standard Reporting there is a folder containing MARC attributes 

as shown below.  
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NOTE: MARC data is not intended to be used in a Dashboard. Because of this, 

no MARC cube is delivered with BLUEcloud Analytics.  

Delivered Reports  

MARC data is accompanied by four 

delivered reports. These objects can be 

found in Shared Reports > MARC. 

Each of these reports is provides a 

different way to analyze MARC data. 

For example, the MARC Lookup Full 

Record report includes three options 

prompts allowing you to specify a 

MARC field, subfield and subfield text.  

After running this report, as with any 

delivered reports, you can make 

adjustments as needed, for instance 

adding View Filters, or removing or 

adding attributes. 

The example below includes a View 

Filter. For more information on View 

Filters consult the section Adding a 

View Filter found within this document.  
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Catalog and Item Data 

Imagine that you would like to create a report that lists all of the titles in 

your ILS system that contain a particular subject heading or a particular 

string of text within a specific MARC field. Within the report you would 

want to include information like title, author and perhaps even item 

barcode or call number. This type of report would be built from Catalog 

and Item data.  

NOTE: For steps on how to create this report, consult Exercise 2 in the List 

Reports section of this document.  

Within Standard Reporting there is a folder containing Catalog attributes 

and one containing Item attributes as shown here.  

 

 

Within a Dashboard, both Item and Catalog attributes are accessible from 

the Catalog Cube.  
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Remember that within a dataset, some attributes can be accessed through 

Standard Reporting and some can only be accessed in a Dashboard. Item 

Barcode is a good example; this attribute can only be accessed in Standard 

Reporting. Consult the Data Reference Guide for more information.  

Delivered Reports & Dashboards 

Item and Catalog data is accompanied by four delivered reports and one 

dashboard (located within the Analysis Documents folder). These objects 

can be found in Shared Reports > Catalog-Item. 

 

Each of these reports is unique and provides a different analysis of your 

catalog/item data. For example, the Collection Item Counts report returns a 

list of Collections (Horizon) or Home Location (Symphony) with a total 

number of items in each collection. For multi-library systems, this 

information is further broken down by library.  

 



BLUEcloud Analytics Training Guide, Page 20 

 

Checkout Data 

Imagine that you would like to create a report that shows the number 

items actively checked out at each of your libraries.  This type of report 

would be built from Checkout data. Checkout data focuses only on items 

that are actively checked out to patrons. 

NOTE: For steps on how to create this report, consult Exercise 3 in the Count 

Reports section of this document.  

Within Standard Reporting there is a folder containing Checkout 

attributes as shown below. Note that this is not a complete list of 

Checkout attributes. 



BLUEcloud Analytics Training Guide, Page 21 

 
 

Within a Dashboard, these same attributes and many more are accessible 

from the Checkouts Cube. Attributes of Catalog-Item and User are 

available within the Checkouts cube, allowing you more granularity in 

reporting. Keep in mind, however, that when using these attributes your 

data is still being limited to current checkouts, i.e. users with current 

checkouts or collections with current checkouts.  

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remember that within a dataset, some attributes can be accessed through 

Standard Reporting and some can only be accessed in a Dashboard. User 

Barcode is a good example; this attribute can only be accessed in Standard 

Reporting. Consult the Data Reference Guide for more information.  
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Delivered Reports & Dashboards 

Checkout data is accompanied by three delivered reports and one 

dashboard (located within the Analysis Documents folder). These objects 

can be found in Shared Reports > Checkout. 

 

Each of these reports is unique and provides a different analysis of items 

currently checked out. For example, the Current Checkouts by Profile Paged 

by Library provides a list of user profiles (Symphony) or borrower types 

(Horizon) and a total number of items currently checked out. For multi-

type libraries, it also provides a drop-down menu allowing you to switch 

to a report specific to that library.  
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Historical Data 

Imagine you are working on the library’s Annual Report. You would like 

to create a report detailing the total annual circulation (checkouts and 

renewals) for each library. This type of report would be built from 

Historical data.  

NOTE: For steps on how to create this report, consult Exercise 4 in the Count 

Reports section of this document. Note that this exercise is only for Symphony 

customers. 

In BLUEcloud Analytics Historical data or Symphony customers, is 

sometimes referred to as transactional data; for Horizon customers, 

statistical data. 

Transactional Data in Symphony - Trans (SYM) 

For Symphony Users, historical reporting depends on two logs within 

Symphony, the historical log and the statistical log.  

The History (Hist) log records every workstation transaction that has 

successfully changed the database. The Hist logs keep track of which 

command was sent, the date and time it was sent, which station and user 

access sent the command, and all of the data entered by the operator to 

perform that command. If a command or wizard changes one or more 

databases, it is logged in the history logs. 

For example, the Hist log records all data during a Charge Item command 

since a charge changes the database. The log would not record a Search 

Item command since searching does not change the database. 

The Statistical (Stat) log is generated from the Hist logs when the nightly 

your Statistics Log (statlog) report runs. Stat logs contain dated entries for 

anonymous transactions. The statlog report copies Hist log transactions 

into a statistics file, removes specific patron and title information, and 

substitutes user and item demographics.  

For transactions for which statistics logs are maintained, a Stat log 

contains exactly the same transactions as the Hist log, except that each 

specific user and item transaction is replaced with general demographic 

information. 

For each suitable transaction in the history file, SirsiDynix Symphony can 

take the user ID (if present) and the item ID and pull from the database 

all of the demographics associated with these two IDs. Functions such as 

charging items and creating holds contain both user and item IDs, so the 
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Statistics Log process replaces them with the appropriate user and item 

demographics. 

For example, this is a standard history log. 

02/02/2005,13:51:43 Station: 029 Request: Sequence #: 13 

Command: Bill User user access:ANNE-UACS clearance:TOP-

SECRET station library:MAIN user ID:ANN amount billed:1.75 

bill reason:DAMAGE itemID:1114-1001 call number:PN6081 

.R435 1987 copy:1 paid in full flag:N 

This is the statistics log created from the above history log. 

02/02/2005,13:51:43 Station: 029 Request: Sequence #: 13 

Command: Bill User user access:ANNE-UACS user cat1:ACTIVE 

user status:DELINQUENT department:LOST profile name:LOST 

user location:DRAFT userlibrary:MAIN call number:PN6081 

.R435 1987 current location:CHECKEDOUT record format:MARC 

home location:STACKS library:MAIN type:DOCUMENT permanent:N 

year of publication:1989 station library:MAIN 

The diagram below illustrates what data the Hist and Stat logs would 

have in common for this particular transaction. This is important because 

the way you will build historical reports in BLUEcloud Analytics 

depends on where this information is accessible. Often times you will be 

able to do the same report from Hist or from Stat, but there may be some 

instances when it is more convenient to use one over the other. 

 

Attributes of Hist will primarily be used if a list of each transaction is 

needed to better understand how something happened in the system. 

Attributes of Stat will primarily be used for aggregating values—

counting how many X occurred over a given period.  

History Log

User ID

Item ID

Amount Billed

Bill Reason

Copy

Payment Status

Stat Log

User Category

User Status

Department

Profile

User Library

Current Location

Home Location

Record Format

Library

Publication Year

Date 

Call Number 

Station Library 

User Access 

Command 

Time 
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The attributes of Hist and Stat are accessible within Standard Reporting 

in the Trans folder. Within Trans you will find a folder for Hist and one 

for Stat as shown below.  

 

  

 

 

Within a Dashboard, three cubes are available to access Transaction date 

from the Stat logs. Note that there is not a delivered cube of Hist data. 

The window below displays after selecting “Create New Dashboard”. 

Notice the cubes available.  

 

The Tran Stat Circulation cube contains only checkout and renewal 

transactions. Tran Stat Checkin contains only check-in information. Trans 

Stat Activity contains transactions for all other commands. Commands 

and their corresponding data codes are discussed in the next section.  
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Command and Data Codes 

As discussed in the previous sections, reporting on transactional data in 

Symphony requires a familiarity with the structure of both the Hist and 

the Stat logs. But this type of reporting also requires a level of familiarity 

with the content of those logs. Both Hist and Stat logs contain two types of 

codes—Command and Data. 

Command codes indicate the type of transaction being done in 

Symphony. Commands represent actions taken. Command codes take 

two forms; a description, such as Bill User, and a two-letter abbreviated 

code, such as BY. In the history log example shown below, notice that Bill 

User is the command.  

02/02/2005,13:51:43 Station: 029 Request: Sequence #: 13 

Command: Bill User user access:ANNE-UACS clearance:TOP-

SECRET station library:MAIN user ID:ANN amount billed:1.75 

bill reason:DAMAGE itemID:1114-1001 call number:PN6081 

.R435 1987 copy:1 paid in full flag:N 

Data codes, on the other hand, represent all of the remaining information 

within a transaction. Data codes give a command context. Below is a list 

of the various data codes that could be associated with a Bill User 

command in the Hist log.  

 

Identifying all of the possible Data codes from Hist that could be reported 

on is sometimes difficult. The Hist logs contain over 2000 different data 

codes, all of which are contained in one attribute, Trans Hist Data Code as 

shown above. The Stat logs however, contain an average of 220 data 

codes and each is broken out into its own unique attribute.  
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One of the delivered reports, discussed below is the Available Historical 

Datacodes. This report is indented to be used only as reference, but it helps 

users in identifying the various Data codes in Hist associated with each 

command.  

Delivered Reports & Dashboards 

Transactional data is accompanied by six delivered reports and three 

dashboards (located within the Analysis Documents folder). These objects 

can be found in Shared Reports > Trans (SYM). 

 

Available Historical Datacodes Report 

As noted above, this report is very useful tool to find a starting point for 

reporting from the Hist logs. It shows the available Data codes for each 

Command code. 

To find the Data code associated with a Command code 

1. From the Page-by bar, select the appropriate command from the 

Trans Hist Command Desc or Trans Hist Command drop-down 

menus.  
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2. Note the available Data codes.  

 

3. If the information you wish to report on is available in Hist, create 

a new report using Hist elements. 

NOTE: The process of creating a report is discussed in more detail in the Basic 

Reports section of this document.  

4. If the information you wish to reports on is not available in this 

list of Data codes, for example Home Location, more than likely it 

is available in the Stat logs. Create a new report using Stat 

elements.  

NOTE: Consult Exercise 5 in the Count Reports section of this document for an 

exercise using home location and the command Add Item. 
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Command Counts Report 

Among the many valuable reports delivered with Symphony transaction 

data is the Command Counts report. This counts all of the commands that 

occurred during a given year, and breaks the information down by 

month. 

NOTE: Because this report is scanning every transaction in your Hist logs, it 

does take some time to run.  

  

Statistical Data in Horizon – Stat (HZN) 

Horizon groups statistics into “stat categories”. Some stat categories are 

further divided into subcategories which are system-defined. Other stat 

categories are divided by stat codes, which are locally defined. All of 

these categories and codes come together to describe data in the Stat 

Summary table of Horizon. It is the Stat Summary table that is accessible 

in BLUEcloud Analytics for historical reporting. 

NOTE: It is important to be familiar with the delivered and locally defined 

elements of Stat Summary before working with Stat (HZN) data in BLUEcloud 

Analytics. For a listing of statistical categories, subcategories and codes please 

consult Appendix A.  

Within BLUEcloud Analytics statistical category attributes are accessible 

within Standard Reporting in the Stat (HZN) folder.  
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Within a Dashboard, there is a delivered cube of Stat Summary data. 

 
 

Historical data is only retained as far back as is defined in the stat 

category. Keep this in mind as you use BLUEcloud Analytics. 

Note that while statistical categories and subcategories are system-

defined, System Administrators can change how Horizon keeps statistics 

for each category or subcategory. If you are not able to report on a given 

time period, it may simply be that your Horizon stat categories are not 

retaining data for that period of time. 

Within the Horizon client, when editing the stat category as shown below 

the following can be modified.  
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 Retention days – You can change the number of days you want to 

retain statistics. 

 Time unit – You can change the time unit you want used for 

tracking statistics.  

 Days until Collapse – You can change the time that elapses before 

daily statistics are collapsed and how you want them collapsed.  
 

 
  

Delivered Reports & Dashboards 

Stat Summary data is accompanied by three delivered reports and one 

dashboards (located within the Analysis Documents folder). These objects 

can be found in Shared Reports > Stat (HZN). 

 

Circulation Statistics (Monthly) 

Among the many valuable reports delivered with Horizon statistical data 

is the Circulation Statistics (Monthly) report. You can choose from any of 

the Horizon Stat Categories via a prompt before running this report. You 

can also select the year and month of interest within the prompt.  
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Depending up the selections made in the filters, the output of this report looks as 

follows. 
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Basic Reports 
Reports are often the best place to start gathering the data you wish to review. Reports 

can later be pulled into Dashboards for further analysis. 

Shared Reports 

BLUEcloud Analytics comes with a set of sample reports, available in the Shared 

Reports folder. Use the steps below to open a sample report and become familiar with a 

standard grid report display. 

To open a shared report 

In this example we’ll open a prompted report, specifically the “Current 

Checkouts by Status and Year” report.  

1. In the Shared Reports folder, open the Checkout folder. 

2. Open the Current Checkouts by Status and Year report. 

3. When prompted, highlight a library from the list. 

NOTE: This report includes a prompt. Not all reports have to include a 

prompt as you will see later in this guide.  

4. Click the arrow  to move the library you selected to the 

Selected column. 

5. Click Run Report. 

The report results are displayed in a grid format. The remaining topics in the section will 

discuss how to create a grid report.  
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Types of Report Views 

Depending on the audience and the type of work being done, you may want to 

view a report in different ways.  

Grid View 

The most common report display style is the Grid view. It is also the 

default display style. Grid view displays reports using a formatted and in 

some cases cross-tabbed display. The following is an example of a report 

displayed as a grid. Notice in the toolbar that the Grid icon  is selected 

by default. 

 

 

Graph View 

The graph view displays report data visually. There are many different 

graph types to choose from. The following figure displays the Graph 

view of a report in the bar graph style. 

To view a report as a graph 

1. Click on the Graph icon  in the toolbar.  
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To display both a grid and graph view 

1. Select the Grid/Graph  icon. 

SQL View 

In addition to the grid and graph views, it is possible to see the SQL used to 

generate your report. The SQL view can help you to troubleshoot or fine-tune 

your report selections. The SQL view also includes statistics related to the 

execution of your report, such as the number of rows and columns, and the 

amount of time it took BLUEcloud analytics to execute the report. 

To see the SQL for a report 

1. From the Tools menu select Report Details Page.  
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2. The SQL is displayed in the SQL Statement area.  
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3. Click Show Advanced Details below the SQL Statement area, to 

see execution statistics for the report. 

 

4. More detailed report information is displayed. 
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5. Click Close  when you are finished.  
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Creating a Simple Report 

Users with Root Access level logins or higher can create new reports in  

BLUEcloud Analytics. For more information about user levels, consult the User 

Access Levels section of this document. 

To create a new, blank report 

1. From the home page click on the New Report icon.  

 
2. Select Blank Report. 

 

 
 

The report opens in Design Mode. Here you will design your report before 

running it. Before you begin designing a report, it is important to understand the 

various sections of the Design Mode window. 
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Design Mode 

The Design Mode is made up of the following sections.  

 

 
 

1. Object Browser pane: use this pane to navigate through the project data to 

locate attributes and metrics to include in your report. In the Object Browser 

you can navigate to All Objects in the project, meaning all of the attributes 

and metrics available in BLUEcloud Analytics. You can also choose to 

navigate only through Report Objects. These two sections of the Objects 

Browser are discussed in more detail below: 

a. Report Objects pane: This provides a list of the objects you have added 

to your report. 

b. All Objects pane: This provides you see the list of all the objects 

available in your project. When you first begin working with reports 

in BLUEcloud analytics, you’ll focus on the Attributes and Metrics 

folders.  

c. MDX Objects pane: This section will display, but will not be 

populated with content. You will not use the MDX Objects pane when 

creating reports.  

d. Notes pane: This provides an area to create and/or review report 

notes. In this section you could add information about how the report 

should be used or the data that is being displayed.  
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e. Related Reports pane: This provides a list of reports and documents 

that are related to the report you are currently working with. 

2. Report Filter pane:  

a. Report Filter pane: allows you add filters to a report to modify what 

data is included in the report results 

b. View Filter pane: click the filter icon  to display View Filter pane in 

addition to the Report Filter pane. This pane also allows you to add 

filters to a report, however view filters do not modify the SQL for the 

report. View filters are applied after the SQL has been executed and 

the results are displayed.  

3. Page-by pane: allows subsets of your report results to be displayed on 

separate pages of the report. For example, you might want to display data for 

different checkout years on different pages using the page-by function.  

4. Template pane: you will drag and drop or double-click attributes and metrics 

from the Object Browser onto this workspace to define your report layout and 

content. 

Adding Attributes 

Attributes are objects in a report that give context or meaning. Non-numeric entities 

such as user profile, checkout year, or any Symphony policy or Horizon code are 

examples of attributes.  

To add an Attribute to a Report 

For this example, we’ll add attributes that are available in the User Cube. 

1. In the All Objects pane, click the List icon to more easily 

navigate through the objects. 

 

2.  Open the Attributes folder, then the Users folder. 
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Scroll through the list of user attributes until you find one you’d like 

to report on. 

For our example we’ll use the User Attribute attributes. 

 NOTE: User Attributes are the equivalent of user categories in Symphony or 

user stat classes in Horizon. For more detailed information on what data a 

particular attribute represents, consult the BLUEcloud Analytics Data Reference 

Guide. Keep in mind too that some attributes are only available in a report while 

others are only available in a dashboard. The Data Reference Guide provides 

detailed information regarding what attributes are available in each object.  

5. Double-click the User Attribute attribute and the User 

Attribute Type attribute into the report template. 
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Adding Metrics 

In the example above, the report template currently has no numbers – just 

two user attributes. If we ran this report as we have designed it now, we 

would have a list of all of the available user attributes and values 

associated with those user attributes. Not every report will have 

numbers. Some will just be a list of information; but in these next steps 

we’ll add a metric, which is an object that allows you to not only insert 

numbers, but perform mathematical and statistical operations on those 

figures in your report. 

To add a Metric to Report 

Continuing with the example from the previous section, let’s say we want 

know the number of users in each of our user categories (Symphony) or 

borrower stat classes (Horizon). 

1. In the All Objects pane, open the Metrics folder, then the Users 

folder. 

2. Scroll through the list of user metrics until you find one you’d like 

to report on. For our example, we’ll use the Number of Users 

metric. 
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3. Click and drag the Number of Users metric into the section of the 

report template that displays the text “Drop Metrics here to add 

data”. 

 

Your report template should now look like this. 

 

NOTE: You are currently still viewing the report in Design Mode. We can make 

many more design changes to this report before we display the results.  
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Removing Attributes or Metrics 

If you find that you have added an attribute or metric to the report by 

mistake, you can easily remove it from the template. For example, let’s 

say we added User Attribute ID to our report template and would like to 

remove it: 

To remove an Attribute or Metric from a Report 

1. Complete one of the following tasks: 

a. Either right-click on the object and select Remove from 

Report: 

 

 

b. Or click on the object in the report template and drag it back to 

the All Objects pane: 

 

The object is removed from the report template. 
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Reordering Columns 

You can easily reorder the display of data in your report by clicking and 

dragging columns in the report template. For our example we’ll want 

User Attribute Type to be to the left of User Attribute. 

To reorder a column in a Report 

1. In the report template, click on the header of the column you 

would like to move. 

 

2. Drag the column to your desired display location. The yellow 

arrow tells you to where the column will be moved.  

 

Your report template should now look like this. 
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Adding Report Filters 

In the example we are currently working with, if we were to run this 

report as it is now, we would retrieve results regarding all of the user 

categories (Symphony) or borrower stat classes (Horizon) in our ILS. It 

may be that we just want a report that will display results from one of 

those categories/classes. For, example in this dataset User Category 2 

represents Counties in this library’s service area. A county has been 

assigned to each user record to correspond with their address 

information. Let’s imagine that we want a report that would count up the 

number of patrons in each of these counties. We’ll need to filter out the 

other User Attribute types (birthdate, User Category 1, User Category 3, 

Department and Preferred Language) leaving only User Category 2 in the 

report results. 

To add a Report Filter 

In our report, we’ll add the User Attribute Type attribute to the report 

filter. This will allow us to filter out unnecessary user categories. 

1. In the All Objects pane, open the Attributes folder, then the 

Users folder. 
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Scroll through the list of user attributes until you find one you’d like 

to report on. 

For our example we’ll use the User Attribute Type attribute. 

NOTE: User Attributes are the equivalent of user categories in Symphony or 

Borrower_bstat classes in Horizon. For more detailed information on what 

data a particular attribute represents, consult the BLUEcloud Analytics 

Data Reference Guide. 

2. Right-click the User Attribute Type attribute and select Add to 

Filter 

 

The attribute is added to the Report Filter pane, defaulted to a 

Qualification filter. For our example, we’ll need to change this to a 

select filter, so that we can select the User Attribute Type from a list 

instead of keying it in.  

NOTE:  For more information about the different types of filters, refer to the 

Types of Filters section in this document.  

3. Change the Radio button to Select. 

 

4. Highlight the User Attribute Type you’ll like to be included in 

this filter and use the arrows to move it to the Selected list.  
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5. Click Apply. 

 

6. The filter is applied. The results will be filtered down to just the 

User Category 2 attribute type. 
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Running a Report 

Once you have added the desired objects to your report and applied 

any necessary report filters, you are ready to run the report and see 

the results.  

To run a Report 

1. Click the Run Report icon in the toolbar. 

 

The report results are displayed. 
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Adding a View Filter 

In Standard Reporting, after running a report, users can apply a View 

Filter which limits the data displayed on the report without the user 

having to re-execute the report. Report filters can be combined with view 

filters within the same report. 

To add a View Filter to a report 

1. In the View Filter pane click Add Condition. 

 

2. In the Filter On: drop-down menu, select and attribute or metric 

from the report.  

 

3. Make selections as needed. In this example we are limiting the 

results of the delivered Lookup Full MARC Record report to only 

display the 245 and 650 fields.  
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4. The report data is filtered and displays only the data you selected 

as shown below.  
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Adding Prompts 

A prompt is a question presented to a user prior to displaying report 

results. How the user answers the question determines what data is 

displayed in the report. For example, a multi-branch library system might 

want a report that prompts a user to select a Library before displaying 

results. The results would then be narrowed down to the Library selected 

in the prompt.  

For our example, let’s add User Profile to our report as a prompt. Then 

we’ll be able to see what user categories are assigned to each of our user 

profiles.  

To add a Prompt to a Report 

In our report, we’ll add the User Profile attribute to the report prompt. 

This will allow us to select a specific user profile(s) before displaying the 

results without having to move into the Design Mode. 

1. In the All Objects pane, open the Attributes folder, then the 

Users folder. 
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Scroll through the list of user attributes until you find one you’d like to 

prompt on. 

For our example we’ll use the User Profile attribute. 

2. Right-click the User Profile attribute and select Add Element 

Prompt to Filter. 

 

If you were following along with the previous examples, your Report 

Filter pane should now look like this. 
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Running a Prompted Report 

If there is a prompt applied to your report, as outlined in the previous 

section, you will first be asked to make a selection from the prompt.  

To choose elements in a Prompt 

In this example you are prompted to select a User Profile. 

1. Click on an element in the Available column. If you need to 

select multiple values, hold the Shift or Ctrl key down on your 

keyboard as needed.  

 

2. Use the arrows to move the highlighted element(s) into the 

Selected column.  

3. Click the Run Report  button.  

Your report results are displayed, filtered down just to the User Profiles 

you selected in the prompt.  

4. If you would like to make different selections in the prompt after 

the report results have been display, click the Re-Prompt icon 

from the toolbar and repeat steps 1 through 3. 
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Saving a Report 

When you save a report, you are not saving it to your computer, or 

saving it to email out to someone. You are saving the definitions of the 

report so that you do not have to design it from scratch again. You will 

save the report to your My Reports or Shared Reports folder, depending 

upon who should have access to it.  

To save a Report 

1. Click the Save icon in the toolbar. 

 

2. In the Save As window, select a save location, name the report 

and, optional, enter a description.  

 

3. Click OK. 
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Sorting Report Data 

Any column or row in a report can be sorted. When sorting data, you can 

determine if the sorting order is either ascending or descending. Data in report is 

sorted by default by the left most column. You can modify this default sort, 

changing how your data is displayed and organized, with a variety of sorting 

options.  

Once a report has been run and the results are displayed, user the Quick Sort 

option, found by right-clicking any column header, to sort data in ascending or 

descending order.  

To perform a quick sort 

1. Right-click in the heading of the column or row to be sorted. 

 

2. Select either Ascending or Descending. 

The data is sorted according to you selection. In the example below 

the Number of Checkouts column has been sorted descending.  
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In addition to the ascending and descending options found in Quick Sort, 

you can sort data in more complex ways using the advanced sorting options. 

To perform an Advanced Sort 

1. From the Data toolbar, click the Sort icon . 

2. The Advanced Sort window displays. Make your sorting 

selections based on the following option descriptions: 

a. Rows: Select this tab to sort data added to the rows in the 

grid report. 

b. Columns: Select this tab to sort data added to the columns 

in the grid report. 

 NOTE: You can sort attributes and/or metrics in both rows and 

columns. Simply select the necessary attributes and/or metrics on the 

Rows and Columns tabs.  

c. Sort By: From the drop-down list, select an attribute or 

metric, then choose whether to sort the values in ascending 

or descending order.  

3. When finished, click OK. The data is sorted according to your 

selections. 
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Exporting Reports 

Printing a report 

To print a report 

1. Click any report to execute it. 

a. From the Home menu, select Print. 

 

The Print Options page opens.  

2. Click the Show Printable Version  button. 

3. The report opens in your browser as a PDF preview. 

4. Select the Print option from your browser.  
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Emailing a report 

To email a report 

1. Click the name of a report to execute it.  

2. From the Home menu, select Send Now. 

 

3. The Send Now dialog box opens. 
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4. Click To:  to locate the email address of the recipient. 

The Recipients Browser opens. 

5. Select an address from the Available column and click the arrow 

 to move the address to the To: Cc: or Bcc: fields as needed.  

If the email address you would like to send to is not in the Available list, 

type the person’s name (Address Name) and email address (Physical 

Address) and click Add to Recipients.  

 

6. Click OK. 

7. Back in the Send Now window, in the Send drop-down list, 

choose how to include the report in the email. Options include: 

a. Data in email - Delivers data in an email message 

b. Data in email and to history list - Delivers data in an email 

message and also creates a message in the History List 

c. Data and link to history list in email - Delivers both data and 

a link to the History List in an email message, and creates a 

message in the History List 
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d. Link to history list in email - Creates a message in the 

History List and delivers a link to History List in an email 

message 

8. If needed, edit the Subject field and enter a Message to be 

included in the email. 

9. If desired, expand the Advanced Options section. With the correct 

permissions a user can:  

a. Select the Password protect zip file check box 

b. Enter a name for the zip file 

c. Select an expiration date for the subscription. 

10. Click OK. 

Exporting data 

You can export reports in a variety of formats including PDF, HTML, 

Excel, and plain text. Before exporting a report, note that you can make 

adjustments to the report’s export settings.  

To export a report 

1. Click the name of a report to execute it.  

2. From the Home menu, select Export, and then select the required 

output format. 

3. The Export Options page opens. 

4. Make any necessary changes to the export options.  

NOTE: You can further modify export options and graph settings in User 

Preferences.  

5. The report displays in the selected application and format. 
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Filtering in Reports 

Stand-alone Filters vs. Report Filters 

A stand-alone filter is a filter created as an independent BLUEcloud Analytics 

object. The benefit of creating a “stand-alone” is that it can then be used on many 

different reports. Remember, in BLUEcloud Analytics filters can also be created 

at the same time the report itself is being created, as we did in the previous 

section. Those filters are generically called “report filters”. Report filters are 

saved with the report’s definitions meaning a report filter cannot be used on any 

other report. Both stand-alone filters and report filters accomplish the same 

results: filters determine what data will be pulled into the report results. 

A report filter can use any of the qualification types described in this section so 

you may apply any of these concepts to both stand-alone and report filters, but 

here we will focus on saving these filters for later and multiple uses. 

Filter Editor 

You can create and save a filter using the Filter Editor. You can also use 

the Filter Editor to modify an existing filter.  

To access the Filter Editor 

1. In BLUEcloud Analytics, on the Home page, click New Filter. 

 

The New Filter page opens. 

2. To create a filter, consult the following sections to determine 

which kind of filter you need. Then follow the steps provided. 
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Adding Stand-alone Filters to a Report 

After you create a filter, you can include it in a report. When placed in a 

report, a filter becomes part of the report’s definitions, pulling in only the 

necessary data each time the report is run.  

To add a Filter to a Report 

1. Open an existing report or create a new blank report 

2. From the Design Mode, in the All Objects pane on the left, 

navigate to the folder where your filter is saved. 

3. To add a filter to the report’s Filter pane, complete one of the 

following tasks: 

a. Drag and drop the filter on the Report Filter pane. 

b.  Double-click the filter to add it to the Report Filter pane. 

c. Right-click the filter and select Add to Filter. 

Almost all reports have attributes, metrics and filters. If needed, use 

the previous sections of this manual to add additional objects to your 

report in addition to your filter.  

To edit a Filter 

1. Click on the filter in BLUEcloud Analytics. The filter opens within 

the Filter Editor. 

 

For details on each filter type that can be created and how to create them, 

consult the appropriate section below.  
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Types of Filters 

Attribute Form Qualification 

Attribute form qualification filters can be created based on any of the 

forms that that attribute might take. For example, the attribute Checkout 

DOW (day of week) has two forms ID, and Description. 

ID: Checkout DOW Description: Checkout DOW 

1 Sunday 

2 Monday 

3 Tuesday 

4 Wednesday 

5 Thursday 

6 Friday 

7 Saturday 

 

Let’s imagine that you are trying to filter the data down to one particular 

day of the week, Sunday. With the Checkout DOW attribute, you could 

set up a qualification filter using the ID as shown below, entering the ID 

for Sunday: 

 

Or, it might be easier to use the Description and type in the word 

“Sunday”, if you do not know the corresponding ID. Note that the 

Description form is case sensitive.  
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To create a Filter based on an Attribute form 

In this example we’ll create a filter that will list users with a last name 

beginning with ‘M’.  

1. From the Home page, click New Filter. 

  

NOTE: Remember that you can also create filters “on-they-fly” within a report. 

The example will walk you through creating a filter so that you can use it in 

multiple reports. If you need to create a filter “one-the-fly” within a report select 

the New Report icon from the home screen and follow steps 2-8 outlined below.  

2. In the All Objects pane on the left, navigate to the attribute you’d 

like to work with.  

3. Right-click on the attribute and select Add to Filter. 

For this example we’ll use the User Last Name attribute.  

 

4. Select the Qualify radio button. 

 

5. In the first drop-down menu, select the form you want to base the 

filter on.  

For this example we only have one option, ID. 
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6. In the second drop-down menu, select the operator that best 

describes how the data should be filtered.  

For this example we’ll select “Begins with”. 

 

7. In the text field, enter the value you are looking for in the data.  

For this example we will enter the letter M. 

 

8. Click Apply. 

9. Click Save-As and save the filter. 

 

10. Click Ok.  

NOTE: For instruction on how to add this filter to a report, consult the previous 

section in this document, “Adding Stand-alone Filters to a Report.” 
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Attribute Element List Qualification 

An attribute element list qualification filters data to display only if it has 

been added to the filter list. We can use the list to include what is selected 

or exclude what is selected using the “In List” and “Not in List” options.  

For example, we might want to filter our data down to a particular library 

or set of libraries in our system as shown below: 

 

To create a Filter based on an Attribute Element list 

In this example, imagine we are in a large multi-type library consortia. 

We have many academic, public and school libraries. We’d like to create a 

filter that would show only the public libraries.  

1. From the Home page, click New Filter. 
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NOTE:  Remember that you can also create filters “on-they-fly” within a report. 

The example will walk you through creating a filter so that you can use it in 

multiple reports. If you need to create a filter “one-the-fly” within a report select 

the New Report icon from the home screen and follow steps 2-7 outlined below.  

2. In the All Objects pane on the left, navigate to the attribute you’d 

like to work with.  

3. Right-click on the attribute and select Add to Filter. 

For this example we’ll use the Checkout Library attribute.  

 

4. Select the Select radio button. 

 

5. Choose whether you would like the libraries to filter data to what 

is selected “In List” or “Not In List” using the list drop-down 

menu. 

 

For this example we use In List, since we have just a few libraries 

to select. You may want to choose “Not In List” if you want to 

keep the majority of the elements and only filter out one or two 

selections.  

 



BLUEcloud Analytics Training Guide, Page 70 

6. Select the elements you would like to include in the filter.  

For this example, we’ll select three of our public libraries. 

 

7. Click Apply. 

8. Click Save-As and save the filter. 

 

9. Click Ok.  

 NOTE: For instruction on how to add this filter to a report, consult the previous 

section in this document, “Adding Stand-alone Filters to a Report.” 

Metric Set qualifications 

Metric set qualifications restrict data based on the value or percentage of a 

metric. For example, a metric set qualification might filter a report to only 

display data if the total number of current checkouts is less than or equal 

to 100 in a given week.  

 

To create a Filter based on a Metric Set  

In this example, imagine we are monitoring those libraries that have a 

low number of current checkouts. We can create a filter that will only 

display data for libraries with 1000 or fewer current checkouts.  
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1. From the Home page, click New Filter. 

  

NOTE: Remember that you can also create filters “on-they-fly” within a report. 

The example will walk you through creating a filter so that you can use it in 

multiple reports. If you need to create a filter “one-the-fly” within a report select 

the New Report icon from the home screen and follow steps 2-5 outlined below.  

2. In the All Objects pane on the left, navigate to the metric you’d 

like to work with.  

3. Right-click on the metric and select Add to Filter. 

For this example we’ll use the Number of Checkouts metric.  

 

4. In the drop-down menu, select the operator that best describes 

how the data should be filtered.  

For this example we’ll select “Less than or equal to”. 
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5. In the text field, enter the value.  

For this example we will enter the value 1000. 

 

6. Click Apply. 

7. Click Save-As and save the filter. 

 

8. Click Ok.  

NOTE: For instruction on how to add this filter to a report, consult the previous 

section in this document, “Adding Stand-alone Filters to a Report.” 
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Custom Groups 

A Custom Group allows users to filter data in a special way in a report. For 

example, you might want to create a group of libraries by type or region, or you 

might want to group checkout dates by Fiscal Year.  

 

Custom groups can be used with Reports. To use the custom groups in a 

dashboard, you must build the dataset as a report and then base the dashboard 

off of that dataset.  

To create a Custom Group 

For this example we will create a custom group for Fiscal Year. We will 

group together checkout dates according to a September 1 through 

August 31 Fiscal Year.  

1. From the Home screen, select the New Custom Group icon. 

 

2.  Click in the area labeled, “Enter customer Group name here.” 
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3. Enter a name for this group. This will be the column header in 

your report.  

For our example we will type “Fiscal Year”. 

 

4. Click New Custom Group Element. 

The condition window displays. 

 

5. Click Browse to select the necessary objects to define the filter.  

For our example we browse to Checkouts > Checkout Date. 
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6. Define the filter conditions. 

NOTE: For more information on filter conditions refer to the Type of Filters 

section in this document.  

For this example, we will use the checkout date ID form which 

allows us to set a qualification of “between”. We will select dates 

between Sep 1, 2014 and Aug 31, 2015 to define the FY15 element 

of our custom group. 

 

7. Click OK. 

The element is added to the group.  

8. Click on text that reads Element Name to rename the element. 

This name will be used in your report to identify this set of data.  

For our example, we will rename this element FY15. 
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9. Hover over the element to see the Duplicate menu.  

 

10. Use the Duplicate menu to easily add other elements.  

For our example we will create elements for FY14 and FY13.  

 

11. Click Save as. 

NOTE: Save this custom group to one of two directories. If you would like the 

group to be available for others to use, save it to the Shared Custom Groups 

folder (Public Options > Shared Custom Groups). If you would like to keep this 

custom group object private, save it to your My Objects folder.  



BLUEcloud Analytics Training Guide, Page 77 

 

To use a Custom Group in a Report 

1. From the home page, click on the New Report icon. 

 
 

2. Select Blank Report. 
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3. In the All Objects pane, navigate to the custom group either 

in the Shared Custom Groups or My Personal Objects > My 

Objects directory.  

4. Click and drag the Custom Group into the report template. 

 

5. Add additional attributes or metrics as needed.  

For our example we will add the Number of Checkout metric 

to see the total number of current checkouts grouped by Fiscal 

Year.  

 

6. Click Run Report.  

The report results are displayed, grouped according to the 

custom group element settings.  
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Report Formatting 
Reports can be formatted in a variety of ways, the result being improved the readability 

and appearance of your report. These reporting options can be done manually or you 

may select from a set of auto-styles. Auto-styles are collections of pre-selected 

formatting options that can be applied to a report all at once.  

Thresholds 

Thresholds are a way to conditionally apply formatting to data. With thresholds, 

you can draw the user’s attention to key pieces of data that meet a certain 

condition, such as “number of checkouts > 1000”. A threshold consists of a 

condition to be met and a color or image to apply. Thresholds can be created 

manually, as with a visual threshold or more easily using a “quick threshold”. 

To add a Quick Threshold 

1. Run a report. 

2. After the report loads, select either the Grid or the Grid/Graph 

view.  

3. Select a metric header on the grid report. To select multiple metric 

headers, hold CTRL and select the headers. 

4. Select the Data toolbar. 

5. Click the arrow next to the Quick Thresholds icon and select an 

option from the drop-down menu. The option you select depends 

on how you want to format the data. 
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To create a Visual Threshold 

1. Run a report. 

2. After the report loads, select either the Grid or the Grid/Graph 

view. 

3. From the Data menu select Visual Threshold Editor.  

 

The editor opens.  

4. In the Thresholds for drop-down list, select the metric for which 

you would like to create a threshold.  

For our example, we will select the Number of Checkouts metrics. 
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5. In the Properties link, click Type. In the Type drop-down list that 

appears, select the type of condition you’d like to use for this 

threshold.  

For this example, we’ll select Value. 

 

6. In the Based on drop-down menu, select if the threshold condition 

should be based on the metric itself or on another metric in the 

report.  

Since our example only contains one metric, the threshold can only be 

based on itself.  

 

7. Click the Apply  check-mark.  

8. To add a threshold value, drag the slider bar to the desired 

position or key in the desired value.  
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9. Click the Check-mark icon to set the value. 

 

A division is added to the slider bar. 

10. Add more divisions as needed using the Add Threshold icon 

in the formatting menu. 

 

11. To format a particular range of values, represented by the area 

between division, double-click anywhere in the space between 

divisions and select Format from the menu.  

 

The formatting menu opens.  
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12. Make selections as needed in the Format window.  

For our example, we will simply change the color of the text to red if 

the current Number of Checkouts is between 0 and 1000.  

 

13. Click Apply to see the changes display in the background. When 

you are satisfied with the threshold settings, click OK. 
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The threshold is applied. 
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Renaming Objects 

It is possible to rename objects in a report. This can be done using an alias. The 

alias renames the attribute or metric in the report, but does not change the name 

anywhere else in the BLUEcloud Analytics project.  

To rename an Attribute or Metric in a Report 

1. From the Data menu, select Rename/Edit Object.  

 

    The Rename/Edit Objects window is displayed. 

2. Select the object you would like to rename from the Object drop-

down menu.  

For this example, we’ll select the Number of Checkouts metric.  
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3. Type in the new Name of the object. 

 

4. Click OK.  

To find the original name of an Object in a Report 

1. From the Data menu, select Rename/Edit Object.  

 

    The Rename/Edit Objects window is displayed. 

2. From the Object drop-down menu, select the object in question. 

3. The Definition box displays the original object name.  
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Notice for this example, the original name of the Current 

Checkouts metric was Number of Checkouts. 
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Autostyles 

BLUEcloud Analytics comes with many preset formatting styles, referred to as 

Autostyles. They can be applied to a grid report from the Grid menu.  

To apply and Autostyle 

1. Select the Grid toolbar.  

 

2. Select an Autostyle from the drop-down menu in the toolbar. 

Corporate is the default. 

For our example, we’ll select the Finance Autostyle. 
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The report is displayed with the Autostyle formatting selected.  
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Basic Dashboards 

Shared Dashboards 

BLUEcloud Analytics comes with a set of sample dashboards, available in the 

Shared Reports folder. Use the steps below to open a sample report and become 

familiar with a standard grid report display. 

To open a shared dashboard 

In the example, we’ll open the delivered Checkout dashboard.  

1. In the Shared Reports folder, open the Checkout folder. 

2. Open the Analysis Documents folder. 

3. Click on the dashboard titled Analysis for Items Currently 

Checked Out. 

 

The dashboard is displayed. The remaining topics in the section will 

discuss how to create a dashboard.  

 

Creating a Simple Dashboard 

To create a new, blank dashboard 

1. Click the New Dashboard button: 

 

2. Next, browse to your Checkouts cube under Shared Reports > 

Cubes > Checkout Cube. 

3. Click Next. 
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4. Next, you will choose a “visualization” which determines if your 

output is a grid or graph. Click the Select a Visualization button. 

 

 

5. In this example, we’ll start with a Grid visualization. Select the 

Grid icon from the list: 
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6. The Checkout Cube may include some default data that you will 

want to clear from the visualization. Click the visualzations’s 

options drop down and select Clear Visualzation: 

 

Adding Attributes 

Attributes are objects in visualization that give context or meaning. Non-

numeric entities such as user names, titles, authors, or any Symphony 

policy or Horizon code are examples of attributes. In our visualization, 

we’ll add a couple of attributes that are available in the Checkouts cube: 

Checkout Library and Checkout Year. 

To add an Attribute to a Dashboard 

1. In the Dataset Objects pane on the left, double-click the Checkout 

Library attribute: 
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You should now have a listing of your libraries: 

 

2. Double-click the Checkout Year Attribute: 

 

 

Your visualization should now look similar to the following: 
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Adding Derived Metrics 

Our analysis currently has no numbers – just two attributes. While not 

every visualization will have numbers, this particular one won’t mean 

much without any. In these steps we’ll add a metric, which is an object 

that allows you to not only insert numbers, but perform mathematical 

and statistical operations on them. 

Let’s say we want the number of checkouts in our visualization. The 

problem: there’s no such metric. The possible solution: is there something 

else in the cube that we might be able to “count” that would reveal the 

number of checkouts? 

The attributes that are in the cube can sometimes open up possibilities for 

a new metric. While there isn’t a metric called “number of checkouts” 

there is an attribute called Checkout Id: 

 

When you see an attribute termed as an “Id”, that means it is a unique 

key assigned to each row. In other words, each checkout ever recorded in 

the cube has a unique checkout Id assigned to it by the system. This 

process happens across many different data points in your database. 

Every user in your system has a unique User Id, every item has a unique 

Item Id, and so on. 

The sample data below shows an example of checkout Ids: 

 

 

The ID numbers are likely gibberish to you. That’s fine, as we’re not 

planning on displaying them. However, they can be useful if we can count 
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them. If you could create a metric that performs a “count” on the 

Checkout Id attribute, you are getting the number of checkouts.  

Then, if you put that metric in a dashboard along with an atttribute like 

the Checkout Library, the metric will display the counts in a way that 

suits the attributes next to it. In other words, you are then getting 

“number of checkouts by library”. 

The example below shows how a “number of checkouts” metric can be 

created and added. 

To Add A Derived Metric to the Visualization 

1. In the Dataset Objects pane, hover your mouse over the 

Checkout Id attribute, and click the drop-down arrow: 

 

2. From the menu, select New Metric > Count: 

 

3. Notice that a new metric called Count (Checkout Id) has been 

added to the Dataset Objects pane: 
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4. Double-click the Count (Checkout Id) metric. It will append to 

the end of the visualization: 
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Removing Attributes or Metrics 

Attributes and/or metrics can be removed from the visualization. In this 

example, we’ll take the Checkout Library attribute out. 

To Remove an Attribute or Metric 

1. Hover your mouse over the header of the attribute or metric in 

question so that you can see the drop-down arrow. 

2. Click the drop-down arrow and select Remove from the menu: 

 

3. The attribute/metric should now be removed from the 

visualization: 
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Reordering Columns 

By default, attributes will display in the order in which you added them. 

This applies to metrics as well (though metrics will always show after the 

right-most attribute). Later, you may want to re-arrange attributes or 

metrics in a different sequence. 

In the example below, we’ll make the Checkout Year the left-most 

attribute. 

To Re-order an Attribute or Metric 

1. Hover your mouse over the Checkout Year column header so you 

can see the drop-down arrow. 

2. From the drop-down menu, select Move Left: 

 

The checkout year should now be the left-most attribute: 

 

You might have noticed that the left-most attribute automatically is 

sorted in ascending order. This holds true until you manually sort the 

data in some other way. 
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Adding a Sort 

By default, BLUEcloud Analytics will sort your visualization by the left-

most column of data. This holds true until you add a sort of your own. 

The example below demonstrates a “simple” sort, done by the Checkout 

Count in descending order. 

To Perform A Simple Sort 

1. Hover your mouse over the column header you’d like to sort by 

so you can see the drop-down arrow. 

2. Click the drop-down menu, and select either Sort Ascending or 

Sort Descending: 

 

3. Your data will now be sorted by that column: 

 

A sort will become part of the definition of the visualization. In other 

words, if you save the dashboard with a sort, that sort will be the default 

the next time it is viewed. 

Sorting by multiple columns is also possible, and will be covered in a 

later chapter. 
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Changing the Visualization 

To this point, we’ve been using a grid visualization. Grids are often a 

great way to begin, but you may later decide that you’d rather display the 

data in a graph format (in the Dashboard Formatting chapter later in this 

guide, we’ll discuss how you could have it both ways). 

BLUEcloud analytics provides you with many different types of graphs 

including bar and pie charts, heat maps, and scatter plots.  

Be aware that you should choose a graph type that is appropriate for 

what you are trying to highlight in the data. For example, if your intent is 

to show how different categories contribute to a whole; a pie chart may 

be the best choice. In another case where you want to highlight changes 

over time, the very same data might be better displayed with a line chart. 

Also, some graph types will only be made available when your data 

meets certain conditions. For example, some of the “stacked area” graphs 

will require multiple attributes and at least one metric, and will not be 

selectable if your visualization doesn’t meet those requirements. 

To Change a Visualization 

1. In the toolbar, click on the Change Visualization button: 
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2. From the Select a Visualization dialog, select the visualization 

category. In this example, we’l select the Pie Chart category: 

 

3. Some visualization categories will have subcategories from which 

you can choose. Notice the pie chart category offers both Pie and 

Ring variants. In this example, we’ll select the Pie subcategory: 
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4. The visualization is now displayed as a pie chart: 

 

Saving the Dashboard 

“Saving” a dashboard means saving the definition so you can run it again 

at a future time without having to recreate it. If a dashboard is intended 

for use by many users, you may want to save it to the Shared Reports 

folder (if your user permissions allow you to do so). The other option is 

the other option is the My Reports folder, which is only visible to your 

BLUEcloud analytics login. 

If you save an object to the Shared Reports folder, it is visible to all users 

by default. However, it is possible secure objects and folders in order to 

limit who sees them.  

To Save a Dashboard 

1. In the toolbar, click the Save button: 

 

2. In the Save As dialog, select where you would like to save the 

dashboard. In this example, we’ll place it in the My Reports 

directory. 
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3. Also in the Save As dialog, provide a name for the dashboard in 

the Name field: 

 

4. The dialog below will confirm your save. You can then either 

Return to original dashboard or Run newly saved dashboard. In 

this case, we’ll click Run newly saved dashboard: 

 

Now that your dashboard is saved, you can bring it back up later at any 

time by double-clicking its icon in the location you saved it: 

 

 



BLUEcloud Analytics Training Guide, Page 104 

Filtering in Dashboards 

Types of Filters 

Many of your analytics projects will incorporate a filter, which is a condition that 

restricts the data displayed. For example, our current visualization could be 

filtered to show only certain checkout years, or only display rows with more 

than 500 checkouts. 

At this point, our visualization is completely unfiltered. We are looking at the 

total count of checkouts across all available checkout years. While this is still 

potentially useful, visualizations are often more meaningful by reducing it to 

only the data you want. Filters are the key to this. 

In traditional reporting, unfiltered data is regarded as undesirable from both a 

performance and comprehension standpoint. However, in analytics, it is the 

nature of the process to start with the entire “cube” of data. You then reduce 

your data set down to what you want through filtering. 

Filtering can be done on both attributes and metrics. In dashboard visualizations, 

there are different interfaces available for filtering, including: 

 

Checkbox: 

 

Slider: 

 

 

Search box: 

 

Radio button: 

 

 

Drop-down: 

 

Some filter display styles are 

more suitable than others 

depending on your intent. For 

example, a slider would be 

handy when you want to select 

from a range of values, while a 

radio button display style is 

useful when you want to permit 

only one selection. 
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Filtering on Attributes 

In many cases, you’ll want to create one or more filters on attributes in 

the dashboard, such as limiting by library or year.  

In this example, we’ll add a slider-style filter to our visualization that 

allows for selection of a range of values from the Checkout Year attribute. 

To Add an Attribute Filter  

1. In the Grid pane, hover your mouse over the attribute or metric so 

you see the drop-down arrow. 

2. Click the drop-down arrow, and from the menu, select Add to 

Filters: 

 

3. The filter interface will default to a checkbox style, as shown 

below: 

 

4. To change the style, hover your mouse over the Checkout Year 

attribute in the Filters pane so you can see the drop-down arrow. 
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5. Click the drop-down arrow, and select Display Style > Slider 

from the menu: 

 

6. The filter interface is now in slider form. Drag the end-arrows 

with your mouse to narrow the range of checkout years. The 

example below has been narrowed to 2009-2011: 

 

7. By default, the filter is inclusive in nature, and is showing only 

data from 2009-2011. If you wish to make it exclusive instead, use 

this menu combination: 
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8. The vizualization is now filtered to show all checkout years except 

for 2009-2011: 

 

 

Filters on Metrics 

When filtering on metrics, you are dealing with numbers on which you 

may want to perform mathematical filters. Because of this, you’ll likely 

want access to common mathematical operators like “greater than”, “less 

than”, “equals”, and other variants. This type of filter where you set such 

a condition is called a qualification metric filter. 

The example below filters a large amount of checkouts by restricting to 

rows with 100 or more checkouts. 

To Add a Metric Filter 

1. In the Edit Visualization pane, hover over the metric to access the 

drop-down arrow (NOTE: if you don’t see the Edit Visualization 

pane, you can enable it in the toolbar in Show > Edit 

Visualization ): 
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2. Click on the arrow, and select Add to Filters from the menu: 

 

3. In the Filters pane, hover your mouse over the metric (in this case 

Count (Checkout Id) so you can access the drop-down arrow: 

 

4. Click on the arrow and select Display Style > Qualification: 
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5. You should now have an interface in the Filters pane similar to 

the following: 

 

6. From the drop-down, make sure Greater than or equal to is 

selected, type 100 into the value box, and press <Enter>. 

7. The grid should now be restricted to rows with 100 or more 

checkouts: 
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Clearing/Deleting Filters 

“Clearing” a filter means clearing the data restriction, yet keeping the 

filter interface visible so you can use it again. By contrast, “deleting” a 

filter involves both clearing the restriction and getting rid of the filter 

interface altogether. 

Filters can be cleared individually or all at once in the event you have 

more than one. Filters can be deleted individually. 

To Clear a Single Filter Condition 

1. In the Filters pane, click the Clear Filter icon next to the attribute 

or metric filter you want to clear: 

 

To Clear all Filter Conditions 

1. In the Filters pane, click the top-most Clear Filter icon: 

 
 

To Delete a Filter 

1. In the Filters pane, hover your mouse over the attribute or metric 

until you see the drop-down arrow. 
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2. Click the drop-down, and select Delete from the menu: 

 

Keep Only 

The Keep Only feature is a nice way to perform a “one-off” filtering 

operation against the original data set, narrowing the data down to just 

the value we select. In the examples below, we’ll start with dashboard 

that displays data from the Checkouts cube, including Checkout Library, 

Checkout Year, Checkout Month, and a Count of checkouts: 

To Keep Only specific Attribute values 

1. In the grid, hover your mouse over the attribute value for rows 

you wish to keep, so you can access the drop-down arrow. In this 

example, any Checkout Library of Hancock will work: 

 
 

2. Click on the drop-down arrow, and select Keep Only: 
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It is important to understand that subsequent Keep Only operations will 

not further filter the data, but rather replace what was done in the previous 

Keep Only operation. 

Let’s extend our last example where we did a Keep Only to reduce rows 

to the Hancock library. What happens if we do another Keep Only on this 

grid with the intent of further reducing the data to the Checkout Year 

2013? Do we really end up with “Checkouts at Hancock in 2013”? 

 

The result: we’ve replaced the previous Keep Only operation. So while the 

data set has been reduced to 2013 checkouts, we’re no longer restricted to 

the Hancock library: 

 

 

The important lesson here: filters are the best way to specify a set of 

conditions you’d like to apply. A couple of filters could easily achieve 

something like “2013 Checkouts at the Hancock library”. Keep Only is 

best used with intent of a one-off change to the original data. 

You can use filters in conjuction with a Keep Only operation and get 

cumulative effects. Just understand that only one Keep Only is operating 

at once. 
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Exclude 

In this first example, instead of keeping a certain dataset, we’re going to 

instead exclude particular pieces of data. We’ll remove rows from the 

grid for a library that is slated for removal from the system (“BEING 

REMOVED – NOT HOLDABLE”).  

To Exclude Data by an Attribute 

1. In the grid, hover your mouse over the attribute value you want to 

exclude so you can access the drop-down arrow: 

 

 

2. Click on the arrow, and from the menu, select Exclude: 

 

In the results, note that all rows for the BEING REMOVED – NOT 

HOLDABLE library have been removed from the grid, even though we 

applied this action to just the first instance of this library. When you 

exclude by an attribute value in this manner, you are excluding ALL rows 

with that value. 

This could this be done with a proper filter, but exclusions give you a 

quick, click-oriented way to get rid of something you don’t want. 

Exclusions can also be applied to metrics. An important distinction from 

attribute exclusions: when performed against a metric, the exclusion 
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removes only the selected row, even if there are other rows that share the 

same metric value. 

In the following example, we’ll target this row for removal: 

 

To Exclude Data by a Metric 

1. Hover your mouse over the metric value so you can access the 

drop-down arrow: 

 

2. Click on the arrow, and select Exclude from the menu: 

 

The selected row has been removed from the results. However, note 

that only that row was removed. Other rows that also have a 

Checkout count of 1 are still in the grid: 

 

 

This is an expected behavior of exclusions when it comes to metrics. 

To achieve a complete removal of rows based on a metric value, use a 

filter. 
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To clear Exclusions 

1. Click on the Filters button above the data set. Here, you can clear 

exclusions one at a time, or clear them all at once: 

 

 

Keep Only and Show 

The Keep Only and Show option allows a user to filter data to a certain 

subset then break that data down in a new way based on the attribute 

selected.  

As a case study for Keep Only and Show, consider this grid which has a 

row of 6 checkouts in August 2013 for the Hancock library: 

 

 

While this is good general information, what if I want to know which 

items were checked out? Or what if I want to know who did the 

checkouts? And in either case: just for that row. 

In the example below, we’ll zoom in on this row of data to explore which 

items were checked out. 

To Use Keep Only and Show 

1. In the grid, hover your mouse over the metric you wish to explore 

so you can access the drop-down arrow: 

 

 

2. Click the arrow, and select Keep Only and Show > Item Id from 

the menu: 



 

BLUEcloud Analytics Training Guide, Page 116 

 

 

3. A new grid appears, showing details about each of the six 

checkouts including the Item Id: 

 

 

To clear Keep Only and Show 

1. Click on the Filters button above the data set. Here, you can 

clear the Keep Only and Show operation: 
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Drilling 

Similar to the Keep Only and Show option, drilling allows you to explore 

data beyond what is visible in the current output. It gives you a way to 

“take a peek” at related data, such as additional attributes that might be 

relevant to the current dataset, but aren’t a permanent part of the 

dashboard. 

Example: you have a dashboard built from the Checkouts cube that 

displays general information such as the library, the date, and the 

number of checkouts. While you like the useful, at-a-glance data it 

provides, say you also want the ability to “zoom in” and see who did the 

checkouts, or perhaps which items were checked out. This is the general 

idea behind drilling. 

In this section, we’ll focus on the Drill feature found in the context menus 

in a dashboard. Drilling can be done on any attribute (like Checkout 

Library) or attribute value (like the Kingston Library). 

With the drill feature, you can include more attributes into the 

dashboard. But not only that, you’re incorporating that new data relative 

to where you initiated the drill. So drilling from a specific library to add 

Item Ids to a dashboard will add Item Id transactions relevant to that 

library.  

Also, the data you incorporate via drilling is subject to whatever filters 

are in place. 
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For illustrative purposes, we’ll explore drilling using very small data sets. 

Bear in mind that drilling can apply to rather large data sets if you like. 

But to facilitate demonstration, let’s start with the grid below that is 

limited to Kingston library checkouts, and only in the years 2007 and 

2012. 

 

In this first example, we’ll drill from the Checkout Year attribute down to 

the Item Id. 

To Drill from an Attribute 

1. Hover your mouse over the attribute so you can access the drop-

down arrow: 

 

2. Click the arrow, and select Drill > Item Id from the menu: 
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3. You should see results like the following: 

 

Two important things happened here: 1) We’re now displaying the Item 

Id instead of the Checkout Year, and 2) we went from 3 rows of data to 7. 

Why the increase in rows? Notice that the original data set had 7 

checkouts total (1 in Feb. 2007, 1 in Oct. 2012, and 5 in Nov. 2012). 

Because we drilled from the Checkout Year attribute (rather than doing it 

from a specific year), we drilled into Item Ids from all years listed (2007 

and 2012). The filters in place also continued to constrain the results to the 

Kingston library. 

To cancel the drill, use the Undo button in the toolbar. 

Now, let’s start with the same original data set, and drill from an attribute 

value. Let’s see what happens when we drill from a specific year, like 

2012. 

To Drill from an Attribute Value 

1. Hover your mouse over the attribute value so you can access the 

drop-down arrow: 

 

 

2. Click the arrow, and select Drill > Item Id from the menu: 
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3. You should see results similar to the following: 

 

The attribute value we drilled from (within the Checkout Year) was 

replaced by what we drilled to (Item Id). This time, we ended up with 6 

rows. Why? Out of the 7 total checkouts from our original data set, 6 of 

the 7 rows were from 2012. The checkout from 2007 was not included.  

To cancel the drill, use the Undo button in the toolbar. 

Notes on Exploring Graph Visualizations 

This chapter largely focused on grid visualizations, mainly because it is easier to 

illustrate how the output is changing by demonstrating with a grid. However, 

graph visualizations also allow for all of the features shown in this chapter.  

The concepts we’ve discussed have the exact same impact in graph 

visualizations; what changes is the method of accessing the features, in most 

cases. 

Filtering 

Creating and altering filters with a graph is no different than with a grid. 

You can access the same Add to Filters option when working with a 

graph: 
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Keep Only/Exclude/Keep Only and Show 

These options are available either by clicking on a specific object in the 

graph (like a specific bar), or by highlighting an area via a mouse drag. In 

the latter case, the operation is performed on the values selected. 

In the example below, a bar is first selected with a mouse click, and then 

the drop-down can be accessed by hovering on it: 

 

In the screenshot below, an area been selected by dragging a box around 

a set of bars. The selected operation will then be applied to all data within 

the bounded area: 
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You can also find Keep Only and Exclude wherever attribute values are 

displayed, such as the checkout library: 

 
 

Drill 

Drilling can also be done against a graph. The trick is to look for the 

attributes and attribute values (the exact location of them can vary 

depending on the type of graph you’ve selected).  

Like drilling in a grid, you can drill against a specific value (the “Coloma” 

library in the screenshot), or do a more general drill against the attribute 

itself (the “Checkout Library”): 

In the screenshot below, we could start a drill s from the checkout library 

of Coloma: 
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If we wanted to drill starting from all checkout libraries currently in the 

dashboard, we could initiate the drill from the attribute itself: 
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Dashboard Formatting 
The dashboards shown in previous chapters were all simple one-grid/one-graph reports. 

Feel free to create simple dashboards. Many consumers of your reports won’t require 

anything more complicated.  

However, some consumers may want a wide range of information available within one 

dashboard. They may want several grids and graphs on one page, or perhaps spread 

across several adjacent pages accessed by tabs. An example of this type of dashboard is 

shown below: 

 

This chapter will discuss usage of visualizations, layouts, and panels, each of which can 

play a role in designing more versatile dashboards. 

The “anatomy” of a dashboard that includes all three of these elements is shown below: 
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Multiple Visualizations 

In this example, we’re going to create a dashboard that initially has 1 layout, and 

three visualizations: 

 

 

Setup: the Visualizations 

Because we’ve already spent previous chapters covering the mechanics of 

creating visualizations, we’ll quickly summarize the content of each one 

here. The step-by-step instructions that follow will focus on the 

arrangement of them into one dashboard. 

Visualization 1: Number of checkouts by month in 2014, restricted to the 

Berlin library. Type: vertical bar chart. 

Visualization 2: Checkouts by day-of-week in 2014, restricted to the 

Berlin library. Type: pie chart. 

Visualization 3: Item status counts, restricted to the Berlin library. Type: 

horizontal bar chart. 
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Setup: Filtering 

When planning a dashboard, a critical thing to understand is this: filtering 

will apply to all visualizations within a given layout, including multiple panels 

within the layout.  

Looking at our planned visualizations, notice that all three of them will 

filter to the Berlin library. Because filters are global in nature within a 

layout, this will be easy to do. As soon as one of the visualizations is 

filtered to the Berlin library, other visualizations in the layout with the 

library attribute will automatically be subject to the same filter. 

Two of the visualizations also have a constraint to the year 2014. As long 

as that filter exists somewhere in the layout, anything in that layout with 

the Checkout Year attribute will be subject to that filter 

If that sounds like a problem: this is where multiple layouts can be useful. 

For example, we could have separate layouts for different libraries, thus 

having a shared dashboard with a tab for each: 

 

In the above example, any visualizations in the Brandon layout would 

not be affected by filters in either of the other two. Each layout could be 

filtered by their own library, leading to a shared dashboard. 

If the idea of a shared dashboard between libraries makes you cringe, you 

can simply design separate dashboards for each, put them in separate 

folders, and secure them accordingly (see the BLUEcloud Analytics 

Administration class for more on this). As stated early in this chapter, not 

everyone is going to go full-steam-ahead on complex dashboards. 

Creating the Dashboard 

In this example, we’ll now create the 1-layout/3-visualizations dashboard. 

On your system, you can vary the library/year options to ones suitable to 

your library’s data. 

To make the example slightly easier to follow, we’ll first create each 

visualization as a grid so that you have a clearer picture of the setup. 
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We’ll then convert them to graphs. Experienced users can by-pass that 

step and create them as graphs to begin with. 

When you have multiple visualizations in a layout, make sure you have 

first selected the one you want to work with using a mouse click. The 

highlighted visualization is the one that your attributes/metrics will be 

added to. 

To Create a Dashboard with Multiple Visualizations 

1. Create a new Dashboard using the Checkouts cube as your data 

source. 

2. In the visualization, create the first example: Number of 

checkouts by month in 2014, restricted to the Berlin library. 

Type: vertical bar chart. Prior to converting it to a bar chart, it 

should look similar to the following in grid form: 

 

 

3. If your visualization was created as a grid, convert the 

visualization to a bar chart using the Change Visualization option 

either in the main toolbar, in in the visualizations drop-down 

menu. 

4. In the main toolbar, select Add Visualization > Grid: 
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5. This should give you an empty visualization box on the right: 

 

 

 

 

 

 

In the new visualzation, create the second example: Checkouts by day-

of-week in 2014, restricted to the Berlin library. Type: pie chart. Prior to 

conversion to a pie-chart, the data should look similar to the following: 

 

 
 

NOTE: You do not have to do any additional filtering, because you already 

created the “Berlin” and “2014” filters for the first visualization. 

6. If your visualization was created as a grid, convert the 

visualization to a bar chart using the Change Visualization option 

either in the main toolbar, in in the visualizations drop-down 

menu. 

7. In the main toolbar, select Add Visualization > Grid: 

 

8. This should give you a new empty visualization off to the right: 
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9. In the new visualization, create the third example: Item status 

counts, restricted to the Berlin library. Type: horizontal bar 

chart. In grid form, your data should look similar to the following: 

 

If your visualization was created as a grid, convert the 

visualization to a vertical bar chart using the Change 

Visualization option either in the main toolbar, in in the 

visualizations drop-down menu. 

10. At this point, your dashboard should look like this: 
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Rearranging the Visualizations 

You may have noticed that visualizations default to a side-by-side 

arrangement. You can alter this arrangement by dragging and dropping 

the visualizations. 

Let’s drag-and-drop the right-most visualization below the other two. 

While dragging, you should see a blue line that shows where the drop 

will occur: 
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The third visualization should now have its own space on the bottom half of the layout: 

 

 

By default, the system will give each visualization an even amount of 

space (50-50 on the top half, in the above example). Be aware that you can 

resize each visualization by dragging it by its borders. 
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Panels 

You can have as many visualizations as you want on a layout. However, the 

more visualizations you have, the less space each one will have to occupy. So 

while you could have ten visualizations on one layout, they would be rather 

small.  

This is where additional panels could come in handy. To this point, we’ve 

actually been putting our visualizations in the default panel of the layout. If you 

want a dashboard to have tons of visualizations that are subject to the same 

filtering conditions, you can subdivide a layout into separate panels. This gives 

you more space to work with.  

To Add Additional Panels to a Layout 

1. In the Tools menu in the main toolbar, select Add Panel: 

 

2. Your layout should now have a new panel in which you can place 

more visualizations: 

 

From this point, you can add visualizations to the new panel using the 

exact same methods you used in the default panel. 
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Additional Layouts 

While panels are used to give you more space within a layout, sometimes you 

may want additional layouts. The chief reason to have multiple layouts is to 

allow for multi-page dashboards where different filter conditions could apply to 

each page.  

For example: our previous dashboard project had one layout filtered to the Berlin 

library. What if, in the same dashboard, I want content that is filtered to the 

Brandon library? I would need a new layout for that, since the existing layout is 

already filtered to Berlin. 

Another possible reason you might use additional layouts: you like the “tabbed” 

look better than the dots-in-a-tab look that panels provide, regardless of filter 

considerations. 

The example below shows creating a new layout. In this case, it is intended to 

provide a tab in the dashboard where visualizations for the Brandon library can 

later be placed. 

To Add a New Layout: 

1. Click on the Add Layout tab next to the existing layout tab: 

 

2. By default, the layout will have a patterned name like layout 1. 

You can rename it by hovering on the new layout tab so you can 

access the drop-down arrow: 

 

3. Then, click on the arrow, and select Rename from the menu: 
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4. Type in the name of the new layout: 

 

You now have a new layout with a default panel. You can add 

visualizations to it using the same methods as before. But let’s introduce 

another method at this point: copying. 

 

  



 

BLUEcloud Analytics Training Guide, Page 136 

Copying / Moving Data 

In a multi-page dashboard scenario, you may sometimes want similar reports 

across different panels or layouts. For example, maybe our new layout for the 

Brandon library wants to have content similar to Berlin’s, but filtered to 

themselves. 

While you could recreate the same visualizations from scratch, it may be easier to 

copy or move any similar visualizations, and then adjust them.  

“Copying” and “moving” mean exactly what they do in other software contexts. 

Copying creates a second, independent copy, while moving transfers the 

visualization from one place to the other. 

Copying and moving can be done between both layouts and specific panels. The 

example below copies one of the Berlin layout’s visualizations over to Brandon’s. 

To Copy / Move a Visualization: 

1. Hover your mouse over the title bar of the visualization so you 

can access the drop-down arrow: 
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2. Click on the arrow, and select Copy to or Move to from the menu: 

 

3. Your options at this point depend on what panels and layouts are 

available (also notice you could create new panels and layouts on-

the-fly this way). In this case, we’ll copy to the Brandon layout: 

 

 

4. The Brandon layout now has the same visualization. 

Be careful here. Just because our visualzation has been dropped into a tab 

of a particular name doesn’t mean the data has technically been altered 

appropriately. This visualization doesn’t truly become the Brandon 

library’s until we adjust the filters within this layout to make it so: 
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Also, the Berlin layout was restricted to the Checkout Year of 2014. If that 

is needed in the Brandon layout, that filter would have to be recreated as 

well. 

Now that that Brandon layout has a filter for the Brandon library, any 

additional visualizations that are copied or moved to it will restrict by 

that filter (as long as the visualization contains the Checkout Library, in 

this case). 
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Text Fields and Renaming Visualizations 

Some finishing touches to this dashboard would be nice. Let’s look at Text Fields 

and Renaming of visualizations. 

Text Fields 

Text fields give you one or more places where you can enter free text 

amongst the visualizations. In this example, we’ll add a caption to the top 

of the Berlin library layout that reads Berlin Library Activity in 2014. 

To Add A Text Field: 

1. In the Tools menu in the main toolbar, select Add Text Field: 

 

 

2. The text field should default to the top of the layout. Within the 

field, type the desired text, such as “Berlin Library Activity in 

2014”: 

 

 

3. If you want to perform additional formatting such as alignment 

and font options, hover your mouse on the text box and click on 

the  icon to the right: 
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4. In the menu that appears above, you can then adjust alignments 

and fonts. 

If needed, you can have multiple text fields. They can also be dragged to 

different sections of the screen just like visualizations, as well as resized. 

Renaming Visualizations 

The default names of visualizations tend to be rather non-descript: 

 

The exercise below renames the left visualization to Checkouts by 

month. 

To Rename a Visualization: 

1. Hover your mouse over the visualization’s title bar so you can 

access the drop-down arrow: 
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2. Click on the arrow, and select Rename from the menu: 

 

 

3. Enter the desired text, such as “Checkouts by month”: 

 

 
Advanced Sorting 

You can perform two types of sorts: a “simple” sort against a column of your 

choosing (discussed previously in this guide), or an “advanced” sort which 

allows for sorting against multiple columns.  

You can sort by as many attributes or metrics as you like. Initially, the sorting 

dialog will provide for three sorts, but it will give you more “slots” to provide 

additional sorts if you use up the existing ones. You can choose an ascending or 

descending option for each sort. 

The example below adds three sorts to a dashboard: by Checkout Library, 

Checkout Year, and Checkout Month.  
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To Perform an Advanced Sort: 

1. In the Edit Visualization pane, hover your mouse over any 

attribute or metric so you can access the drop-down arrow: 

 

  

2. Click on the arrow, and from the menu select Advanced Sort: 

 

  

3. In the Sort dialog, select up to three sorts, similar to the example 

below: 
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4. Click OK to finish the sort. The results should look similar to the 

following: 

 

 

Tips for Sorting Chronologically: 

In the previous example, notice that our months are sorted alphabetically. 

That may not be how you expected the months to be sorted, but it is 

technically correct. That is because, in step 3 above, we sorted by the 

Checkout Month Name attribute. Since our only options are ascending or 

descending in Advanced Sort, the month names are sorted alphabetically, 

rather than chronologically. 

 



 

BLUEcloud Analytics Training Guide, Page 144 

 
 

 

When performing your sort, pay careful attention to a couple of things: 

Date attributes like month or day-of-week may provide you a numeric 

option—for example, months are considered as 1 (January) through 12 

(December)) in addition to the name version of the attribute. Examples are 

shown below.  

The 

numeric option leads to a more logical sort in these cases:Sorting on the 
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numeric version of the attribute (CKO Checkout Month) will result is the 

following display: 
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Page-by 

The Page-by feature provides a convenient way to view a large data set in slices. 

It is designed to be used with grid visualizations. 

For example, take the following output from a checkouts dashboard that goes on 

for potentially thousands of rows, especially when little filtering is applied: 

 

 

 

 

One obvious solution to a large data set is to apply filters. Another option that 

may help is Page-by, which lets you “split” the data by an attribute into different 

pages, rather than one enormous page of data. 

The example below moves Checkout Library into the Page-by axis, and allows 

you to choose the library via a drop-down. 

To Use the Page-By Feature: 

1. In the Grid pane, hover your mouse over the Checkout Library 

attribute so you can access the drop-down arrow: 
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2. Click on the arrow, and select Add to Page-by: 

 
 

3. The data should now be separated into “pages”, where each 

library can be selected with buttons: 

 

 

4. If desired, you can change the Page-by interface to either a slider 

or drop-down interface by hovering over the attribute in the Page-

by attributes so you can access the drop-down arrow: 
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5. Click on the arrow, and select Drop-down from the menu: 

 

 

You can now select the library in drop-down form: 
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Move to Columns 

All of grid visualizations so far have been of the “vertical” type, where all data 

displays on the y-axis. Sometimes you may want to display one or more 

attributes across the x-axis to enhance readability. For example, how could we 

display a grid where the Checkout Month displays like this? 

 

The example below shows the Move to Columns feature. 

To Use Move to Columns: 

6. In a grid visualization, hover you mouse over an attribute like the 

Checkout Month so you can access the drop-down arrow: 
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7. Click on the arrow, and select Move to Columns from the menu: 

 

 

8. The grid should now show the chosen attribute along the x-axis. 

This does leave one formatting issue: let’s say you want to fix the 

repetitive Count (Checkout Id) notations as shown below: 

 

 

In the Checkout Month drop-down, we can use the Move Down option, 

resulting in this: 
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Thresholds 

Thresholds are a way to conditionally apply background colors to metrics in grid 

visualizations. With thresholds, you can draw the user’s attention to key pieces 

of data that meet a certain condition, such as “number of checkouts > 1000”. A 

thresholds consists of a condition to be met, and a color to apply.  

The example below will demonstrate creating three thresholds. To simplify 

things, we’ll work against this small grid: 

 

Our three thresholds will be: 

1. Number of checkouts < 100: Green 

2. Number of checkouts between 100 and 1000: Blue 

3. Number of checkouts > 1000: Red 

The system will default to giving you five threshold “ranges”, which you can 

add to or subtract from. Since our example requires only three ranges, part of the 

process will be taking two of them out. 

To Add A Threshold to Grid Visualization: 

14. In the Grid pane, access the drop-down arrow next to the 

Checkout Id metric, and select Thresholds… from the menu: 
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15. By default, the system should give you this dialog which defaults 

to five threshold ranges (two of which we’re going to delete): 

 

 

16. To delete a threshold range, hover your mouse within the box, 

and click on the “x” to delete it: 
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17. Repeat step 3 and delete one more threshold range (it doesn’t 

matter which one. For this example, just make sure you end of 

with three ranges). At this point, your threshold dialog should 

look something like this: 

 

 

18. Next, we’ll make a change so that the thresholds are based on 

exact numbers we specify, rather than the Lowest % basis that it is 

defaulted to. Click on the Based on: Lowest % in the drop-down, 

and select Value: 

 

 
 

19. Next, we’ll set the left threshold range to look for values “less than 

100”. The easiest way to set an exact value is to click on the slider, 

at which point you’ll get a pop-up to fill in 100: 
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20. Our next theshold range (the middle) will end at 1000. Set it in a 

manner similar to step 6, as per the screenshot below: 

 

 

21. The third (right) threshold doesn’t require any addtional work as 

far as the condition goes. It simply encompasses the remaining 

values not covered by the other two thresholds. 

22. To set the color for the first (left) theshold, hover your mouse 

within its range box, so you can see the color button: 

 

 

23. From the color dialog, pick a background color for the first 

threshold (since the text will be in black, make sure to pick a 

lighter shade): 
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24. Repeat step 10 for both the second and third threshold ranges. 

You should end up with something similar to the following: 

 

 

If you no longer want to use thresholds, you can clear them by 

accessing the drop-down for the metric in the Grid pane, and 

selecting Clear Thresholds: 
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Color-by 

Color By is the same concept as thresholds, except that they are intended for 

graph visualizations. The methods used to create Color By effects are also very 

similar to those used in thresholds, as the two main components are a condition, 

and a color to use when that condition is met. 

In the example below, we’ll do a Color By on the following graph of checkouts 

by library/year: 

 

There will be two conditions: blue bars for checkouts < 30, red bars if > 30. 
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To Use Color By in a Graph Visualization: 

1. In the Graph pane, click on the Add button in Color By: 

 

 

2. From the dialog, select the metric off of which you’ll be basing the 

Color By. In this case, we’ll mark the Count (Checkout Id) metric 

and click OK: 
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3. In the Graph pane in Color By, click on the Thresholds icon: 

 

 

4. By default, the system provides you five threshold “ranges”. We 

only need two for this example, so we’ll delete three of them. To 

delete a range box, hover your mouse within it and click the ‘x”: 

 

 

5. Repeat step 4 until you are left with two ranges as follows: 

 

6. Next, we’ll make a change to the Based on setting so that we can 

set exact numbers that define the Color By scheme. Click on the 

Based on: drop down, and select Value from the menu: 
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7. Next, we’ll set the value of the left threshold range (checkouts < 

30). To do this, either drag the slider, or click on it and enter 30 in 

the text box: 

 

 

8. The second (right) threshold range requires to further settings as 

far as conditions, as it will account for all values not covered by 

the first threshold. 

9. Next, we can select colors for each threshold range. The left 

threshold already has a blue color that we wanted. To change the 

second threshold to a red color, hover your mouse over it and 

click the Edit Color button: 
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10. From the color dialog, select a color, and click the OK button: 

 

 

11. Your Color By settings will be applied to the graph: 
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Totals/Subtotals 

If your report includes one or more metrics, you have the option to perform 

many different types of calculations on them. These include standard 

“aggregate” functions like counting, sums, and averages, or statistical functions 

such as standard deviation and variance. 

This section will cover the application of these functions using two of the most 

common: grand totals and subtotals. 

Grand Totals 

A grand total can be placed in a visualization by invoking the totaling 

function on the left-most attribute. The example below will apply a grand 

total of the Count (Checkout Id) metric by applying a totaling function to 

the Checkout Library attribute. Our test visualization will consist of the 

data below: 

 

 

To Add A Grand Total: 

1. Access the drop-down arrow on the header of the left-most 

attribute, select Show Totals from the menu: 
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2. You should see a list of functions you can apply (you can select 

more than one, if needed). Check the box next to Total and click 

OK: 

 

 

3. You should see results similar to the following: 

 

 
 

Subtotals 

Subtotals are totals broken out by a certain category. Using our simple 

visualization from a previous example, this shows subtotals by Checkout 

Library: 
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Subtotals “by attribute” are generated by invoking the totaling function 

on the attribute to the right. In other words the subtotals “by library” in 

the above grid were created by invoking the totaling function on the 

Checkout Year, which happened to be the next attribute. 

The steps below illustrate this in detail. 

To Add a Subtotal: 

1. On the attribute to right of the category you’d like a subtotal 

breakdown, click on the drop-down arrow for the header of the 

attribute and select Show Totals. Since we want subtotals by 

Checkout Library, we’ll perform this act on the next attribute, 

which is Checkout Year: 

 

 

2. You should see a list of functions you can apply (you can select 

more than one, if needed). Check the box next to Total and click 

OK: 
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You should have results like the following: 

 

 

 

  



 

BLUEcloud Analytics Training Guide, Page 165 

Reports as Dashboard Datasets 

While it may feel somewhat limiting to have attributes that are only available in 

Standard Reporting, you can create a report but then use that report as a dataset in a 

Dashboard for further analysis. The search feature, flexible filters, groups and 

metrics within Reports can make it easier to create the data you wish to view in a 

dashboard. 

After you build a report and save it, use the Create Dashboard option found in the 

Tools toolbar, to bring the elements of your report into a dashboard. No 

visualizations will be created, but attributes not normally available in dashboards, if 

included in your report are now available. Keep in mind when doing this that ONLY 

the objects you add to your report will be available in the dashboard. If you make 

modifications to the source report, like adding additional metrics, the dashboard will 

be updated to reflect those additions automatically. This feature allows users further 

analyze their data with the dynamic visualizations available within Dashboards.  
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Search Tips 

Boolean Searching 

The Quick Search box, available from the Home menu and within any folder, 

allows you to use Boolean operators--AND or OR and NOT--to search your 

instance of BLUEcloud Analytics for the folders and objects you create. An 

example is shown in the image below. 

 
 

You can also place double quotes around terms to search them as a phrase such 

as “Northside Academic”. 

The plus (+) and minus (-) signs can be used to include or exclude specific words 

from a search. If you need to search for a special character, such as a plus or 

minus sign, type a backslash (\) before the character. This indicates that the 

character is part of the search term and is not to be used as an operator.  

NOTE: When using the Quick Search box if search suggestions are not displayed as you 

type, “Quick Search” is not enabled and Boolean operators cannot be used. Enable Quick 

Search in Preferences > Project Defaults. 

Wildcard Searching 

Wildcard searching can be used within Reports. Wildcard characters are 

especially useful when using view filters and prompts.  

 Use the asterisk (*) to substitute for one or more characters or if you are 

unsure of a particular phrase.  
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 Use the question mark (?) to replace one character. This can be helpful 

when you are unsure of case as searching in BLUEcloud Analytics is case 

sensitive.  

 

 Use the underscore (_) for positional matching. This is especially 

useful when searching, for example, fixed field data in a 008 tag. In 

the example below, 23 underscores were entered before the letter “d” 

in order to search the 23rd position. After the letter d, an asterisk was 

entered because there are additional positions after the 23rd. 

 

NOTE: In order for the above to be successful, this would need to be 

combined with a filter on the Bib MARC Tag Number limited to just 

the 008 field. 

 Any text that is included inside double quotes is treated as a phrase. 

 Enter a blank space, a comma or the word OR to indicate a logical OR 

between two search terms. 

 

 Enter an ampersand symbol (&) or the word AND to indicate a logical 

AND between two search terms. 

 The use of a minus symbol (-) placed at the beginning of a search term 

or the word NOT indicates a logical AND NOT between two 

conditions. 
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Administration 

User Creation 

At this time, all user creation is handled by Customer Support. Users should 

submit a ticket via the Support Portal including a list of the users to be created 

and the passwords for each account.  

User Preferences 

Options for working with BLUEcloud Analytics objects can be customized for 

individual users. Once Client Care has created users for a particular instance, 

that user or an administrative user can log in and change their user preferences. 

Examples of what can be defaulted in the Preferences menu include language, 

default home page, print and export settings, and much more.  

To set user preferences in BLUEcloud Analytics 

1. Log in to BLUEcloud Analytics using the user name and 

password for the account that needs adjustment. 

2. From the upper left of any page, click the BCA Start icon. 
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3. Select Preferences.  

The General preferences page is displayed. 

4. In the left navigation, select a Preferences page containing the 

options that are to be modified. 
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Importing Data Files 

Data from an Excel spreadsheet (.xls or .xlsx) or a CSV file can be loaded into 

BLUEcloud Analytics with very few layout or design requirements. The data can 

be imported used in a report, dashboard or a document.  

 

Only Admin and creator level users have the permissions to import data, 

however, once uploaded, Analyst users could use the data in a dashboard. View 

users could view the data in a dashboard. 

 

NOTE: Each Admin and Creator user can upload a total of 250MB of data. Check your 

usage of this space by clicking the Import Data icon from the Home Screen.  

Once uploaded the data is saved as a cube. Depending on the structure of the 

data imported, the cube will contain various attributes and metrics. It important 

to keep in mind that these imported attributes and metrics can be added to 

reports and visualizations, but cannot be joined with other tables or cubes in 

BLUEcloud Analytics; meaning in one visualization or report you could not add 

imported and delivered attributes and metrics.  

To import data from a file into BLUEcloud Analytics: 

1. On the home page, click the Import Data icon. 

Or, from within a folder, click Create on the icon bar on the left. 

Then click Import Data. 

 

2. From the Select your Data Source panel to the left, click the File 

icon. 

 

3. Click Browse. 

The Select a File to Upload window displays. 

4. Select a file to import, then click Open. 
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5. In the lower right corner of the screen, click Continue. 

A preview of the imported data is displayed on the Preview page.  

6. If the file is an Excel workbook with more than one sheet of data, 

from the Sheet Name drop-down list, select the sheet from which 

data should be imported. 

By default, BLUEcloud Analytics assumes that data is stored in a 

simple tabular, layout. Users can also choose to import data stored 

in a cross-tabbed layout.  

7. Select Tabular or Cross-tabbed and complete the following steps 

as needed. 

If Cross-tabbed is selected, the legend in the top right shows how 

each type of data is displayed. As needed, complete the following 

steps for cross-tabbed formats.  

a. Highlight each cell containing metric data by clicking and 

dragging the edges of the Metric data area.  

b. Check the “No Metric Headers” check box if no metric 

headers are contained in the file. 

c. If metric headers are included in the file, uncheck the “No 

Metric Headers” check box. 

d. Click and drag the Metric header block area to highlight the 

cells containing header information. 

If Tabular is selected, adjustments cannot be made to the data 

areas as described above, however, a user can add or modify 

column headers if necessary as follows. These headers are used as 

the names of the attributes and metrics being defined, so it is 

important that they are accurate. Complete the following steps to 

create new headers when none are displayed:  

a. Check the “Insert new column headers” check box. A new 

column header is inserted for each column. 

b. Hover the cursor over a column header and click the arrow 

icon in the top right area of the cell. 

c. Select Rename. Enter a new name for the header. 

d. Press Enter on the keyboard. 
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8. Once all the necessary changes have been made, in the lower right 

corner of the screen, click Continue. 

The “Save Dataset” window is displayed. Depending on the 

permissions of the user creating this new dataset, they may have a 

choice in where to save the dataset.  
 

 

9. In the drop-down menu, select the appropriate save location. 

10. Enter a file Name and a Description if desired. 

11. Click OK. 

A confirmation screen displays. From this screen, users can select a type 

of object they wish to create with this data cube—report, document or 

dashboard—and begin analyzing the data immediately.  
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Sharing Objects  

Users with “full control” of an object and those with administrative privileges 

can decide if other users or groups of users have access to that particular object. 

This is handled by editing an object’s access control list in the “Share” submenu. 

As an example, permission might be set to allow a user to view and run a report 

while keeping the user from saving over or deleting a report. In addition to 

setting sharing permissions, users can also use the Share submenu to share a link 

to the object via email.  

 NOTE: When modifying the permissions for a folder, changes will be applied to 

the folder and all objects created in the folder in the future. If it is necessary to 

apply these permission to items already in the folder, select the “Overwrite all 

child object” permissions check box.  

The table below describes the permissions which can be assigned to a user or 

group of users. These permissions do not apply to cubes. 

Permission Level Description 

View A user may browse, read and execute the object. 

Modify A user may both view and modify the object including write and delete permissions. 

Full Control Grants all permissions for the object, including the ability to view, modify and delete the object. 
Users can also grant permissions for the object to other users. 

Denied All No permissions for the object are granted.  

Custom The user assigning permissions may create a custom combination of permissions. A pop-up 
menu displays after selecting Custom which allows a user to select the permissions. 

 

The following table lists the permissions which can be assigned to cubes. 

Permission Level Description 

Consume A user may create or run reports with the cube. 

Add In addition to creating and running reports, a user can republish or refresh the cube. 

Collaborate User has all permissions and can also modify the cube. 

Denied All No permissions for the object are granted.  

Custom The user assigning permissions may create a custom combination of permissions. A pop-up 
menu displays after selecting Custom which allows a user to select the permissions. 
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To assign object permissions to a user or user group  

1. From within a folder, right-click on the object and select Share.  

 

 

Or, from within an open report, document or dashboard click the 

Share icon on the Home toolbar.  

 

The “Share” dialog box is displayed. 
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 NOTE: You can save an object (a folder, dashboard, report etc.) to the Shared 

Reports folder and then set access levels as discussed below. Only after you 

grant users access to the object they will see it in their Shared Reports folder. 

You can also save the object in your My Reports folder and set permission levels 

but you must provide a link to users in order for them to be able to access the 

object. Links are provided in the Sharing Options section of the Share window. 

2. The “Who has access” section lists the users and groups who have 

or can have access to this object. To grant all users access to the 

object, select the All Users check box. Or, use the Type users or 

groups here textbox to enter the name of each user or user group 

the object should be shared to. 

 

3. With either option, a drop-down menu is displayed. The user or 

user group is assigned View permissions by default. Use the View 

drop-down menu to change permissions. 
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Users can choose from the delivered permissions levels (described 

in detail in the above tables) or choose their own combination of 

permission to assign.  

4. To assign custom permission, select Custom. 

 

5. In the Custom Permissions Level window, select permissions to 

assign to this object. 

6. Click OK. 

7. If needed, provide to users a link to this object from the Sharing 

Options section of the Share window.  
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Subscribing to Objects 

BLUEcloud Analytics administrators and users can create email, file and print 

subscriptions in a variety of ways. These subscriptions can be set up for reports, 

documents and, when using email subscriptions, for dashboards as well.  

To create and email subscription in an open report or document: 

1. From the Home menu, point to Subscribe to and select E-mail 
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2. In the Subscribe to Email Window, enter a Name for this email. 

3. Select a Schedule for sending this email. 

NOTE:  BLUEcloud Analytics is delivered with schedules, if additional 

schedules with different frequencies are required, please contact Client Care. 

4. Select an appropriate email address or use the To drop-down 

menu to do the same. 

 NOTE: If this is the first subscription being created, or if there are no 

addresses in a user’s preferences, the To: drop-down menu will not be 

displayed. Use the To: button to add recipients. 

5. In the Send drop-down list, choose how to include the report in 

the email. Options include: 

a. Data in email - Delivers data in an email message 

b. Data in email and to history list - Delivers data in an email 

message and also creates a message in the History List 

c. Data and link to history list in email - Delivers both data and a 

link to the History List in an email message, and creates a 

message in the History List 

d. Link to history list in email - Creates a message in the History 

List and delivers a link to History List in an email message 



 

BLUEcloud Analytics Training Guide, Page 179 

6. Enter a Subject. 

7. If it is necessary to preview the report or document, select the 

Send a preview now check box. 

8. If desired, expand the Advanced Options section. With the correct 

permissions a user can:  

a. Select the Password protect zip file check box 

b. Enter a name for the zip file 

c. Select an expiration date for the subscription. 

9. Click OK. 

A message displays confirming the subscription was created 

successfully. 
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File Subscriptions 

Creating a subscription to a file is similar to creating a subscription to email. 

When creating a subscription to file, however, users will specify to which folder 

the object will be saved. This will typically be a shared folder within BLUEcloud 

Analytics. 

 NOTE: With the appropriate privileges, users can create his or her own file 

location. File locations must be accessible by the BLUEcloud Analytics server for 

the subscription to execute successfully. Permission to save to the Shared Folder 

is set in the user login. If a user needs access to save to the Shared Folder, this 

can be set up by contacting Client Care. 

With the proper permissions, users can compress a saved and password protect 

it. All users can set an end delivery date using the Do not deliver after option. 

The following image shows a sample file subscription defined in the Subscribe to 

File window. 
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Print Subscriptions 

When creating a print subscription, scheduling options include subscription 

name, schedule, expiration date, and instant preview. Users can also define a 

printer location, range of pages to be printed, number of copies and whether to 

collate to printed document.  

 NOTE: If users with the appropriate privileges, users can create his or her own 

print location. If a user needs to set up a print location please contact Client Care 

for assistance. 

The following image shows the “Subscribe to Printer” window. 

 

 

 



 

BLUEcloud Analytics Training Guide, Page 182 

Appendix A: 
Horizon Statistical Categories 

Stat Categories 

All Horizon statistics are kept by category. Each category keeps different statistical 

information. This table lists all the statistical categories with their codes and 

descriptions. 

Category Description 

acqacup Acquisitions Actual Cost to Unit Price Ratio 

acqaft Acquisitions Average Fill Time 

acqapf Acquisitions Average Percentage Fill 

acqclam Acquisitions # of Claims 

acqeav Acquisitions Extended Amounts Vouched 

acqecfd Acquisitions Extra Charges to Dollar Product Ratio 

acqecv Acquisitions Extra Charges Vouched 

acqio Acquisitions Items Ordered 

acqir Acquisitions Items Received by Vendor 

acqirb Acquisitions Items Received by Budget 

acqlo Acquisitions Lines Ordered 

acqlr Acquisitions Lines Received 

acqpols PO-Line Stat 

authdel Auth Adds/Deletes 

bibdel Bib Adds/Deletes 

bordel Borrower Adds/Deletes 

cki Check In Transaction Totals 

cko Check Out Transaction Totals 

ckostk Check Out Stock Rotation Transaction Totals 

crcbs Circulation--BStat 

crcbt Circulation--BType 

crcgp Circulation--Stock Rotation Group 

crcisca Circulation--IStat by Call# 

crcisco Circulation--IStat by Collection 

crcit Circulation--IType 

crcrt Circulation--Stock Rotation Route 

credit Moneys Credited 

fee Moneys Levied 

feewave Moneys Waived 

hlp Holds Placed 



 

BLUEcloud Analytics Training Guide, Page 183 

hlr Holds Resolved 

ihu In-house Usage 

ihuisca In-house Usage--IStat by Call# 

ihuisco In-house Usage--IStat by Collection 

ihuit In-house Usage--IType 

itdel Item Adds/Deletes 

moncol Moneys Collected 

monlev Moneys Levied 

monwav Moneys Waived 

nbbs # of Borrowers--BStat 

nbbt # of Borrowers--BType 

nigp # of Items-- Stock Rotation Group 

niisca # of Items--IStat by Call# 

niisco # of Items--IStat by Collection 

niit # of Items--IType 

nirt # of Items-- Stock Rotation Route 

od Overdue Notices 

payment Moneys Collected 

refund Moneys Refunded 

rqp Requests Placed 

rqr Requests Resolved 

Stat Sub-Categories 

Some Stat Categories are further broken down in Horizon into Sub-Categories. The table 

below lists each the sub-categories that correspond to a category. Descriptions of each 

are provided.  

Category Description Sub Category Description 

acqeav Acquisitions Extended 
Amounts Vouched 

0 Extended Amounts 

authdel Auth Adds/Deletes 1 New (Manual) 

  2 Deleted (Manual) 

  3 New (Batch) 

  4 Deleted (Batch) 

  5 New (Acq) 

bibdel Bib Adds/Deletes 1 New (Manual) 

    2 Deleted (Manual) 

    3 New (Batch) 

    4 Deleted (Batch) 

    5 New (Acq) 

bordel Bib Adds/Deletes 1 New (Manual) 

  2 Deleted (Manual) 
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  3 New (Batch) 

  4 Deleted (Batch) 

cki Check In Transaction 
Totals 

1 Normal 

    2 Late 

    3 Offline Normal 

    4 Offline Late 

cko Check Out 
Transaction Totals 

1 1st Time 

  2 Phone Renewal 

  3 Renewal 

  4 Opac Renewal 

  5 Offline 1st Time 

  6 Offline Renewal 

ckostk Check Out Stock 
Rotation Transaction 
Totals 

1 1st Time 

    2 Phone Renewal 

    3 Renewal 

    4 Opac Renewal 

    5 Offline 1st Time 

    6 Offline Renewal 

hlr Holds Resolved 1 Picked Up 

  2 Cancelled 

  3 Expired 

ihu In-house Usage 0 In House Use 

itdel Item Adds/Deletes 1 New (Manual) 

  2 Deleted (Manual) 

  3 New (Batch) 

  4 Deleted (Batch) 

  5 New (Acq) 

moncol Moneys Collected 1 Fines 

    2 Lost Book 

    3 Damaged 

    4 Fees 

monlev Moneys Levied 1 Fines 

  2 Lost Book 

  3 Damaged 

  4 Fees 

monwav Moneys Waived 1 Fines 

    2 Lost Book 

    3 Damaged 

    4 Fees 

od Overdue Notices 1 1st Notice 
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  2 2nd Notice 

  3 3rd Notice 

  4 4th Notice 

  5 5th Notice 

  6 Final Notice 

rqp Requests Placed 0 Placed 

rqr Requests Resolved 1 Cancelled 

  2 Filled 

  3 Expired 

Stat Categories and Stat Codes 

Some Stat Categories are further broken down in Horizon into Stat Codes. The table 

below lists each stat code that corresponds to a category. Descriptions of each are 

provided. Note that the codes themselves are locally defined. A stat code of BTYPE, for 

example, would have values that differ from organization to organization. All Stat 

Categories include Stat Location information—allowing you to report on the location or 

Library of, for example, the checkout. Some stat categories and corresponding stat codes 

include borrower location as well as item location information. Stat codes which allow 

this are indicated below.  

Category Description Stat Code Stat Borrower 
Location 

Stat Item 
Location 

crcbs Circulation--BStat BSTAT Yes Yes 

crcbt Circulation--BType BTYPE Yes Yes 

crcgp Circulation--Stock Rotation Group STOCK Yes Yes 

crcisca Circulation--IStat by Call# ISTAT Yes Yes 

crcisco Circulation--IStat by Collection ISTAT Yes Yes 

crcit Circulation--IType ITYPE Yes Yes 

crcrt Circulation--Stock Rotation Route ROUTE Yes Yes 

ihuisca In-house Usage--IStat by Call# ISTAT No Yes 

ihuisco In-house Usage--IStat by 
Collection 

ISTAT No Yes 

ihuit In-house Usage--IType ITYPE No Yes 

nbbs # of Borrowers--BStat BSTAT No No 

nbbt # of Borrowers--BType BSTAT No No 

nigp # of Items-- Stock Rotation Group GROUP No No 

niisca # of Items--IStat by Call# ISTAT No No 

niisco # of Items--IStat by Collection ISTAT No No 

niit # of Items--IType ITYPE No No 

nirt # of Items-- Stock Rotation Route ROUTE No No 
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Appendix B: 
BLUEcloud Analytics Exercises 

List Reports 

Exercise 1: Create a User List Report 

Objective 

Create a list of users that have been expired for over a year. 

NOTE: Some of the attributes within the User Cube are considered “Personally 

Identifiable Information” (PII). If you have not enabled PII on your system you 

may not have access to the User Last Name attribute used in this exercise.  

 

Create the Blank Report 

1. From the home screen, click on the New Report icon. 

2. Select Blank Report. 

Add Attributes 

3. From the All Objects pane search for the attributes by name. 
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Or open the Attributes folder then the User folder to select the 

necessary attributes. 

4. Add the following attributes to add them to the report template: 

 User Barcode 

 User Expiration Date 

 User Last Name 

 User Library 

Add a Filter 

5. Add a filter that will isolate only those patrons that have been 

expired for over a year. 

 Right-click on the User Expiration Date attribute and select 

Add to Filter in the right-click menu. 

 In the filters pane, with the Qualify radio button selected, 

change the qualification drop-down menu from “Equals” 

to “Less than or equal to”. 

 In the search box enter a date that is one year from today. 

 Click the Apply button. 

 Run the Report 

6. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 
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7. Review the report results.  

Save the Report 

8. From the Home toolbar, click the Save icon. 

9. Select a save location. 

10. Enter a name for this report. 

11. Click OK. 

12. Select the “Run newly saved report” button. 

Export the Report to Excel 

13. From the Home toolbar select the Export icon. This is the third icon 

from the right.  

14. In the Export page that displays, review the export settings, 

making adjustments as needed. 

15. Click the Export button. 

16. Save the Excel document if needed. 

Exercise 2: Create a Title List Report 

Objective 

Create a list of titles that, in the bibliographic data, contain a particular 

MARC field/tag. For this exercise, you will be focusing on the 526 note 

field. We’re not looking for any particular data within that field, just for 

records where that field exists. 
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Create the Blank Report 

1. From the home screen, click on the New Report icon. 

2. Select Blank Report. 

Add Attributes 

3. From the All Objects pane search for the attributes by name. 
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Or open the Attributes folder then the appropriate folder(s) to select 

the necessary attributes. 

4. Select the following attributes to add them to the report template 

 From the Item folder 

 Item Barcode 

 Item Call Number 

 From the Catalog folder 

 Catalog Author 

 Catalog Title 

NOTE: If you are viewing the All Objects pane in the List 

hierarchy. Remember that you need to switch to the Catalog folder in 

the drop down menu at the top of the All Objects column. To switch 

from List to the more easy-to-browse Tree view, click the  icon. 

 From the MARC folder 

 Bib MARC Tag Number 

 Bib MARC Subfield Name 

 Bib MARC Subfield Data 

Add a Filter 

5. Add a filter that will isolate only the 526 note with the MARC 

record. 

 Right-click on the Bib MARC Tag Number attribute and 

select Add to Filter in the right-click menu. 

 In the filters pane, click the Select radio button. 

 Use the search box to search for the 526 tag/field. 

 Once located, use the arrows to move the field to the 

Selected column or double-click the field.  

 Click the Apply button. 
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 Run the Report 

6. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 

7. Review the report results.  

Save the Report 

8. From the Home toolbar, click the Save icon. 

9. Select a save location. 

10. Enter a name for this report. 

11. Click OK. 

12. Select the “Run newly saved report” button. 

Export the Report as a PDF 

13. From the Home toolbar select the PDF icon. This is the second icon 

from the right.  

14. In the Export page that displays, review the export settings. The 

ideal export settings for this report are as follows. 

 Scaling: 

 Select the Fit to: radio button. 

 The default value in this field is “1 page wide by 1 

page tall.” For best results with this report, delete 

the value of 1 from the second field (tall), leaving it 

blank 

 Orientation - Landscape 

15. Click the Export button. 

16. Save or print the PDF as needed. 
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Exercise 3: Create a “Most Popular Titles” Title List Report  

NOTE: This exercise is intended to be completed by Symphony customers. 

Objective 

For each Collection/Home Location within the library, create a list of the 

most popular titles. The time period for this list could span years, months, 

weeks, even days. For this exercise we will limit the results to current 

calendar year. 

 

Create the Blank Report 

1. From the home screen, click on the New Report icon. 

2. Select Blank Report. 

Add Attributes 

17. From the All Objects pane search for the following attributes by 

name. Or open the Attributes folder then the appropriate folder(s) to 

select the necessary attributes as 

follows.  
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a. Add the Catalog Title attribute to the report template. 

b. Add the Item Barcode attribute to the report template. 

c. Add the Trans Hist ID attribute to the report template. 

Derive a Metric 

3. Within the All Objects pane, 

Select Report Objects. 

4. Right-click on the Trans Hist 

ID attribute and select Insert 

Metric > Count. A Count (Trans Hist ID) attribute is created and is 

added to the report template. 

5. Within the report template 

a. Right-click on the Item 

Barcode column header and 

select Remove from Grid. 

b. Do the same for the Trans 

Hist ID attribute.  

NOTE: This step is important. We do not want a list of all of the item 

barcodes displaying in the Grid, but we do need access to the Item 

Barcode attribute in the report in order to join the item, catalog and hist 

tables. 

Add a Filter 

6. Add a filter that will isolate only checkout transactions. 

a. From the All Objects pane, open the Attributes folder. Or, 

search by the attribute name “Trans Hist Command Desc” 

and skip to step c. 

b. Open the Trans folder, then open the Hist folder. 

c. Click and drag the Trans Hist Command Desc attribute into 

the report filter or right click on the attribute and select 

Add to Filter. 

d. In the filters pane, click the Select radio button.  

e. Locate the Charge Item Part B command and move it into 

the Selected column. 
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NOTE: There are multiple “pages” of commands. User the 

Search for: box to easily locate the desired commands.  

a. Click the Apply button. 

7. Add a filter that will isolate the current calendar year. 

NOTE: Consult the section regarding Custom Group for information on 

Fiscal Year reporting.   

a. From the All Objects pane open the Attributes folder, then 

the Trans folder, then the Hist folder. Right-click on the 

Trans Hist Year and select Add to Filter in the right-click 

menu. 

b. In the filters pane, click the Select radio button.  

c. Select the current year and move it into the Selected column 

by double-clicking or using the arrows. 

d. Click the Apply button. 

8. Add a page-by filter that will filter the report by collection and 

allow selection of a collection from the page-by drop-down menu. 

 From the All Objects pane open the Attributes folder then 

the Item folder. 

 Click and drag the Item Collection attribute into the Page-by 

pane. 

Run the Report 

9. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 

10. Right-click on the Count (Trans Hist ID) column and select Sort > 

Descending to see the most popular titles at the top.  

11. Review the report results, selecting a collection from the Page-by 

drop-down menu to page through different collections.  

Save the Report 

12. From the Home toolbar, click the Save icon. 

13. Select a save location. 

14. Enter a name for this report. 
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15. Click OK 

16. Select the “Run newly saved report” button. 

Count Reports 

Exercise 1: Create a Report of Collection Totals 

Objective 

Create a report detailing the number of items and the value of each 

library collection.   

 

Create the Blank Report 

17. From the home screen, click on the New Report icon. 

18. Select Blank Report. 

Add Attributes 

19. From the All Objects pane, open the Attributes folder. 

20. Open the Item folder and double-click the Item Collection attribute 

to add it to the report template. 

Add Metrics 

21. From the All Objects pane, open the Metrics folder. 

22. Open the Item folder and double-click the following metrics to add 

them to the report template 
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 Item Price 

 Number of Items 

Run the Report 

23. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 

24. Review the report results.  

Format the Item Price Column 

25. In the report results, right-click on the Item Price column header.  

26. In the right-click menu, select Advanced formatting…  

27. Click on the Number tab. 

28. Select the Currency radio button. 

29. Click OK. 

Save the Report 

30. From the Home toolbar, click the Save icon. 

31. Select a save location. 

32. Enter a name for this report. 

33. Click OK 

34. Select the “Run newly saved report” button. 

Export the Report as a PDF 

35. From the Home toolbar select the PDF icon. This is the second icon 

from the right.  

17. In the Export page that displays, review the export settings, 

making adjustments as needed. 

36. Click the Export button. 

37. Save or print the PDF as needed. 
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Exercise 2: Create a Report of Total Active Users 

Objective 

Create a report detailing the number of users, broken down by 

btype/profile that have been active in the last year. 

 

Create the Blank Report 

1. From the home screen, click on the New Report icon. 

2. Select Blank Report. 

Add Attributes 

3. From the All Objects pane, open the Attributes folder. 

4. Open the User folder and double-click the User Profile attribute to 

add it to the report template. 

Add Metrics 

5. From the All Objects pane, open the Metrics folder. 

6. Open the User folder and double-click the Number of Users metric 

to add it to the report template. 
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Add a Filter 

7. Add a filter that will isolate only those patrons that have been 

active in the past 365 days. 

e. Right-click on the User Last Activity Date attribute (return to 

Attributes folder > User folder) and select Add to Filter in the 

right-click menu. 

f. In the filters pane, with the Qualify radio button selected, 

change the qualification drop-down menu from “Equals” 

to “Greater than or equal to”. 

g. In the search box enter a date that is one year prior to 

today. 

h. Click the Apply button. 

Run the Report 

8. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 

9. Review the report results.  

Display the Report as a Pie Chart 

10. From the Home toolbar, select the Graph or Grid and Graph icon. 

11. From the Graph toolbar, select the Graph Type drop-down menu. 

This is the first drop-down menu displayed from the left. 

12. Change the display style to Pie. 

NOTE: If many pie charts are displayed instead of just one, from the Graph 

toolbar, select the Series by Row icon to change the display to one pie chart. 

NOTE: If the pie chart is displaying across multiple pages, from the Graph 

toolbar, adjust the Series value as needed.  

Save the Report 

13. From the Home toolbar, click the Save icon. 

14. Select a save location. 

15. Enter a name for this report. 

16. Click OK. 
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17. Select the “Run newly saved report” button. 

Export the Report as a PDF 

18. From the Home toolbar select the PDF icon. This is the second icon 

from the right.  

19. In the Export page that displays, review the export settings, 

making adjustments as needed. 

20. Click the Export button. 

21. Save or print the PDF as needed. 

Exercise 3: Create a Report of Total Items Checked Out 

Objective 

Create a report detailing the number of items actively checked out at each 

library. 

    

Create the Blank Report 

1. From the home screen, click on the New Report icon. 

2. Select Blank Report. 

Add Attributes 

3. From the All Objects pane, open the Attributes folder. 
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4. Open the Checkouts folder and double-click the Checkout Library 

attribute to add it to the report template. 

Add Metrics 

5. From the All Objects pane, open the Metrics folder. 

6. Open the Checkouts folder and double-click the Number of 

Checkouts metric to add it to the report template. 

Run the Report 

7. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 

8. Review the report results.  

Save the Report 

9. From the Home toolbar, click the Save icon. 

10. Select a save location. 

11. Enter a name for this report. 

12. Click OK 

13. Select the “Run newly saved report” button. 

Email the report 

14. From the Home toolbar select the Send Now icon. This is the fifth 

icon from the right.  

18. In the Send Now window that displays, use the To: button to enter 

an email address.  

19. After entering and address (recipient) name and the Physical 

(email) address click Add to Recipients. 

20. Click OK.  

21. Back in the Send Now window, leave all other settings as they are 

delivered. 

NOTE: Consult the help documentation for more information on the Send Now 

settings.  

22. Click OK.  
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Exercise 4 (SYM): Create a Report of Annual Circulation by 
Library 

NOTE: This exercise is intended to be completed by Symphony customers. 

Objective 

Create a report detailing the annual total circulation (checkouts and 

renewals) for each library. The report should include the last four years of 

circulation data. 

 

Create the Blank Report 

1. From the home screen, click on the New Report icon. 

2. Select Blank Report. 

Add Attributes 

3. From the All Objects pane, open the Attributes folder. 

4. Open the Trans folder then the Stat folder and double-click the 

Trans Stat Station Library attribute to add it to the report template. 

5. From the same folder double-click the Trans Stat Year attribute to 

add it to the template. 

Add Metrics 

6. From the All Objects pane, open the Metrics folder. 
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7. Open the Trans folder then the Stat folder and double-click the 

Number of Statistical Transactions metric to add it to the report 

template. 

Add a Filter 

8. Add a filter that will isolate only checkout and renewal 

transactions.  

i. From the All Objects pane open the Trans folder then the 

Stat folder. Right-click on the Trans Stat Command Desc 

attribute and select Add to Filter in the right-click menu. 

j. In the filters pane, click the Select radio button.  

k. Locate the following commands and move them into the 

Selected column: Renew Item, Renew User Part B and 

Charge Item Part B. 

NOTE: There are multiple “pages” of commands. User the 

Search for: box to easily locate the desired commands.  

l. Click the Apply button. 

9. Add a filter that will isolate the last four calendar years of data. 

NOTE: Consult the section regarding Custom Group for information on 

Fiscal Year reporting.   

m. From the All Objects pane open the Trans folder then the 

Stat folder. Right-click on the Trans Stat Year and select Add 

to Filter in the right-click menu. 

n. In the filters pane, click the Select radio button.  

o. Select the last four years and move them into the Selected 

column. 

NOTE: Hold down the Ctrl while clicking to select multiple 

years. 

p. Click the Apply button. 

Run the Report 

10. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 

11. Review the report results.  
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Export the Report as a Spreadsheet 

12. From the Home toolbar select the Export icon. This is the third icon 

from the right.  

13. In the Export page that displays, review the export settings, 

making adjustments as needed. 

14. Click the Export button. Save or print the spreadsheet as needed. 

Exercise 5 (SYM): Create a Report of Items Added Monthly by 
Home Location 

NOTE: This exercise is intended to be completed by Symphony customers. 

Objective 

Create a report detailing the total number of items added monthly to each 

Home Location. This report should include the current month of data, 

sorted in descending order.  

 

Create the Blank Report 

1. From the home screen, click on the New Report icon. 

2. Select Blank Report. 

Add Attributes 

3. From the All Objects pane, open the Attributes folder. 
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4. Open the Trans folder then the Stat folder and double-click the 

Trans Stat Home Location attribute to add it to the report template. 

5. From the same folder double-click the Trans Stat Month attribute 

to add it to the template. 

Add Metrics 

6. From the All Objects pane, open the Metrics folder. 

7. Open the Trans folder then the Stat folder and double-click the 

Number of Statistical Transactions metric to add it to the report 

template. 

Add a Filter 

8. Add a filter that will isolate only add item transactions.  

a. From the All Objects pane open the Trans folder then the 

Stat folder. Right-click on the Trans Stat Command Desc and 

select Add to Filter in the right-click menu. 

b. In the filters pane, click the Select radio button.  

c. Locate the Add Item command and move it into the Selected 

column 

NOTE: There are multiple “pages” of commands. User the 

Search for: box to easily locate the desired commands.  

d. Click the Apply button. 

9. Add a filter that will isolate the current calendar year of data. 

e. From the All Objects pane open the Trans folder then the 

Stat folder. Right-click on the Trans Stat Year and select Add 

to Filter in the right-click menu. 

f. In the filters pane, click the Select radio button.  

g. Select the current year and move them into the Selected 

column. 

h. Click the Apply button. 

10. Add a filter that will isolate the last three months of data. 
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i. From the All Objects pane open the Trans folder then the 

Stat folder. Right-click on the Trans Stat Month and select 

Add to Filter in the right-click menu. 

j. In the filters pane, click the Select radio button.  

k. Select the current year and move them into the Selected 

column.. 

l. Click the Apply button. 

Sort the results in Descending Order 

11. Right-click on the Number of Statistical Transactions column header.  

12. From the right-click menu, select Sort > Descending. 

Run the Report 

13. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 

14. Review the report results.  

Export the Report as a Spreadsheet 

15. From the Home toolbar select the Export icon. This is the third icon 

from the right.  

16. In the Export page that displays, review the export settings, 

making adjustments as needed. 

17. Click the Export button. 

18. Save or print the spreadsheet as needed. 

Exercise 5 (HZN): Create a Report of Items Added and Deleted 
Monthly by Library 

NOTE: This exercise is intended to be completed by Horizon customers. 

Objective 

Create a report detailing the total number of items added and deleted 

each month at each Library during the current year.  
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Create the Blank Report 

1. From the home screen, click on the New Report icon. 

2. Select Blank Report. 

Add Attributes 

3. From the All Objects pane, open the Attributes folder. 

4. Open the Stat (HZN) folder and double-click the Stat Location 

attribute to add it to the report template. 

5. From the same folder double-click the Stat Month attribute to add 

it to the template. 

6. Click and drag the Stat Subcategory attribute into the report 

template, adding it to columns to create a cross-tabbed display.  

NOTE: When clicking and dragging an attribute into the report template, watch 

for the “yellow line” which indicates if the attribute will be added to rows 

(vertical line) or columns (horizontal line). 

Add Metrics 

7. From the All Objects pane, open the Metrics folder. 

8. Open the Stat folder and double-click the Stat Total metric to add 

it to the report template. 

Add a Filter 

9. Add a filter that will isolate only statistics representing the 

addition and deletion of items.  
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a. From the All Objects pane open the Stat (HZN) folder. 

Right-click on the Stat Category attribute and select Add to 

Filter in the right-click menu. 

b. In the filters pane, click the Select radio button.  

c. Locate the “itdel” category which represents items added 

and deleted. Move it into the Selected column. 

d. Click the Apply button. 

10. Add a filter that will isolate only statistics for the current year.  

e. From the All Objects pane open the Stat (HZN) folder. 

Right-click on the Stat Year attribute and select Add to Filter 

in the right-click menu. 

f. In the filters pane, click the Select radio button.  

g. Locate the current year. Move it into the Selected column. 

h. Click the Apply button. 

Run the Report 

11. From the toolbar, click the Run Report icon. This is the first icon 

from the left. 

12. Review the report results.  

NOTE: Stat Subcategories are listed as numeric values. If you are not familiar 

with Stat Subcategories, consult Appendix A for explanations of each value. As 

an example, in the image below, since a filter has been applied to limit the 

category to “itdel”, the subcategories are then 1 (items added manually) and 2 

(items deleted manually). Meaning Springville library had added the most items 

during the month of May. They deleted the most items during the month of 

December. 
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Visualizations 

Exercise 1: User Status Visualization 

Objective 

Create a visualization within a Dashboard showing each user profile 

broken down by user status (Symphony: User Status; Horizon: Approved 

Status). 

 

Create the Dashboard 

1. From the home screen, click on the New Dashboard icon. 

2. Navigate to the Shared Reports > Cubes folder.  

3. Select the Checkout Cube. 

4. Click Next. 

Add Attributes 

5. From the Dataset Objects pane double-click the CKO User Profile 

attribute to add it to the visualization. 

6. Double-click the CKO User Status attribute to add it to the 

visualization. 
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Add Metrics 

7. From the Dataset Objects pane locate the CKO User Id attribute. 

8. Using the hover menu select New Metric > Count to derive a metric 

from the CKO User Id attribute. 

9. Scroll to the bottom of the Dataset Objects pane. Double-click the 

metric you have just created (Count (CKO User Id)) to add it to  the 

visualization.  

Add a Filter 

10. From the Edit Visualization pane, hover over CKO User Profile. 

Select Add to Filters.  

11. De-select the user profiles you are not interested in. 

For example, you may have user profiles similar to the following: 

HOMEBOUND, J-RESTRCT, LIMITED3, PUBLIC and TEACHER. 

Limit the results to these types of profiles as needed. 

Change the Visualization to a Graph 

12. Hover over the grey bar at the top of the visualization. From the 

hover menu, select Change Visualization. 

13. From the Select a Visualization window, select the Bubble Grid 

visualization. 

Color the display by CKO User Status 

14. From the Edit Visualization pane, within the Color by section, click 

on the plus sign or “add” icon. 

15. From the list that displayed, select CKO User Status.  

Rename the Visualization 

16. Hover over the grey bar at the top of the visualization. From the 

hover menu, select Rename. 

17. The grey bar now displays a text box. Enter a name for this 

visualization. 

Save the Dashboard 

18. From the toolbar, click the Save icon. 

19. Select a save location. 
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20. Enter a name for this Dashboard. 

21. Click OK 

22. Select the “Run newly saved dashboard” button. 

Export the Visualization as an image 

23. Hover over the grey bar at the top of the visualization. From the 

hover menu, select Export > Image. 

24. Select a save location. 

25. Enter name for this file. 

26. Click Save. 

 

 

 

 


